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GW2AR %% FPGA 7= i it
GWINZ %% FPGA 7= 5 34 T it
GWI1NSR %71 FPGA 7= 5 5048 T it
Gowin & iH 28R
Gowin 8 F i ib 5 7t it

©CoOo~NoOhwDdR

SUG100-1.6 1(73)




1 KT ARFM 1.4 RiE. 4ingiE

10. Gowin fE£8 B AT A H P 185
11. Gowin Zh#Es- T T HAH e/
12. Gowin IP #%/= 4 T HH P 45 rd

1.4 R\ FMiE
AT AT | A8 FH R XU 11
%11 A%, BWE

ARG G TH AR P
CRC Cyclic Redundancy Check TEIR TR S
CS Wafer Level Chip Scale Package s [ 0y 2
DLL Delay-locked Loop JEIR B AH A
FPGA Field Programmable Gate Array W] e TFES)
FF Flip-Flop fiih 5
IDE :Enrtsﬁzﬁ?ndertl)tevelopment R T PR
IP Core Intellectual Property Core R PR
LQ Low-profile Quad Flat Package IR DY T V- 2
MAC Media Access Control S A A5
MG Micro Ball Grid Array Package T B BRA 51 Jf 25
PC Personal Computer N NITHEAL
PLL Phase-locked Loop BFHIA
PG Plastic Ball Grid Array BRI IR R 571 £ 2
ON Quad Flat No-lead Package VU757 Vo 5| s
RTL Register Transfer Level A AE AL

Ultra Ball Grid Array Package T8 i TR TR 2 271 2

1.5 FARZ SRR

s PRI I T A BORSIRE, AR IR A A AR e 5 1) B
WEES AR

Mk www.gowinsemi.com.cn

E-mail: support@gowinsemi.com
Tel: +86 755 8262 0391

SUG100-1.6 2(73)



http://www.gowinsemi.com.cn/
file:///C:/Users/Yanan/AppData/Roaming/Microsoft/Word/support@gowinsemi.com

2 TIRHAT IR 2.1 i/

27—:\7‘}%7&1#1%‘1?

2.1 v

Gowin VAT = E = R ARARYE B A 77 i B R H— AR
FPGA T R IR EE, SCReil FH RE AR IRE 5, FBhH P IRGE S FPGA
TR SRR ARG ZE A i A 2o A0 ELAR IR SO AR R N 3055 A, Bhah,
Gowin = IFRHAFEERL T IP B A plias, B P IRGEH S 0 vk BBk T
7E2% debug T HELLB 4 )T GAO (Gowin Analysis Oscilloscope), 1
T PO E AL AT T E 5 ) R

NT WP IARITE R, Gowin = EHA-GIEE R TREH, H N\ SCIFEE
A DU Pl AR R R R S RS 10 RTL 20t e, al BUZRH 7 RTL
Wit@ Z5a Ja A RS

Gowin = JRHA SR TR B BT A B B L1, n] i b e 56 2 R SCA
# % Synthesize & Place&Route fiz1745 %, FFREIE B shm = Sk
FPGA F# T E¥ LR SO R B F, SEBUH P 3L 7 I Th A% - Gowin
VR A 2-1 P

SUG100-1.6 3(73)




— i tl: s N 1
2 IR 2.2 P SCHF
: 3]
& 2-1 Gowin ZiEHGFEE
{{) GOWIN FPGA Designer - [Start Page] o |
. Hle Edit Tools Window Help AR
O = S
Recent Frojects
Quick Start
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Gowin = VA S RERTE A
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e LUT4s Flip-Flops | MULT18 x 18 | PLL | #f% P

WLCSP30
QN32
QFN48

LQFN100
LQFN144

GWI1N-1 1,152 864 0 1 4/5/6

WLCSP72

QFN32

QFNSS
QFN48

LQFP100
LQFP144

MBGA160

PBGA256
PBGA256M
WLCSP72
QFN32
QFN88

GW1N-2 2,304 1,728 16 2 4/5/6

GW1N-2B 2,304 1,728 16 2

QFN48 4/5/6
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16
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16
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20
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6480

20

LQFP144

UBGA332
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LQFP100

QFN88
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3 WA A 3.1ia173E

SRR

S—fp=
3.1 BITHER
Windows: Win7/8/10(64bit). Win7/winXP(32bit)
Linux: Centos6/7(64bit). Red Hat 6/7(64bit). SUSE 11/12(64bit)

3.2 B TH
Gowin Z IR AE 2345y Windows FRAFT Linux A, Wi &5 w5
= SR E AT N 3
e Windows R4t IR ATN “ ZIRHAE for win(Vx.x.xBeta)” , T
bk www.gowinsemi.cn/fag.aspx

o Linux fRAREHEEIEN, ZHN “=IEHAE for Linux(Vx.x.xBeta)” ,
NE Mk www.gowinsemi.cn/fag.aspx

o HRIFTREGAT, MGTEMEMIFES.
BAF AR B AFR “VxxxBeta” 1 “x” RoRPAFHIRA S .

o 4% Gowin mUEHIFRET, ESCH] 360 B 1L EE B AR TR AT

o IR LAERRAT M AN SCREE A T OCEE AR SR A

o T LLSHIRA Gowin ZIREAMF, UEIE EMRAZ G, FRIRELE
o  Windows T4 RRE L REH T, AT FRI 2R N3k 3-1 PR
%% 3-1 Components to Install

Components ik H/iE

Gowin FPGA Gowin =IREAFEML | WP $AT X E R E R T
designer GUI JaEi 8] \X.X\IDE\bin\gw_ide.exe

Device Gowin ZF NTH, T | o s ity 447 SCLEAE %% H 3 F
programmer i programmer {# FH 3045 \x.x\Programmer\bin\programmer.e
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3.3 Bz
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Components s e

Xe;

® XtV A SR AR

\X.x\Programmer\doc-

Synthesis Gowin Zi& TR, fiff |,

F A
tool ® LA T SCR B
\X.x\SynplifyPro\doc.

® U HAT A LR H T
\X.x\SynplifyPro\bin\synplify_pro.ex

Windows &%t

£ Windows & %i %3 Gowin =#f:, ES % T L.
1. Wil dets, MImFRRBRIN 23,

®H!

o AR AT AR Y 7 T U R H %

o RIS, SBAE PC LA E by 5 <R,

2. XWipuET R “BEE”, 77T Gowin ZVRELF 1 .
Linux &%t

£ Linux 24t T, fREXMERIE, @7 N4
path/x.x.xBeta/IDE/bin/gw_ide, B[] T &4 F i
!
T EAEF root AR A 3 programmer
!

WA P 21723550 Gowin =R AE, kw3 s, il SynplifyPro 254 T H 1 H B2
S i) Gowin YRR 23 A R AL T [F— X~ , BAR TN s,

H.ir “Tools > Options”, #RJaik#¥ SynplifyPro 12 3ik4e, WK 3-1 fin.
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3 mIR s 3.4 BAEVE AT IE ingk (Windows)

[ 3-1 SynplifyPro J§H &R
rg\} Options @1

Synplify Pro

g . Symplify Pro
%, Environment

@ Default (Symplify Fro for GOWIN)
== Text Editor

() Custom

, External Editor Fath: Browse

€5 synplify Pro I

[#]itens request restart program 0 | Cencel ][ apply

3.4 T AEME (Windows)
37 5, TN AIE (License) A fEIEH T4, Gowin
Zo VR A B4 AT IE AL
e SynplifyPro Zi& T BV AlE;
o TRk T B YFAiE.
Gowin = YA VF T UE SZFR T € YA E (Node-Locked License)
AEEhYFATIE (Floating License).

B8 E = ST M www.gowinsemi.cn/fag view.aspx H iR
License.

A AT IEAE SN 7 1615 2 % 3.5SynplifyPro License H# /% 3.6 fii
JEAi £k T H License IN#.
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3 mIR s 3.5SynplifyPro License hn#

3.5 SynplifyPro License JI#
3.5.1 i R EFATE

TR AR R T AL MAC Huhik BT BRI AT e, AN BR AL
it . Y3 SynplifyPro (7 i BUE VFAIIESG , 1275 DL T PR3
E!
F1"C:\Synopsys\"B 1% et ki T H, FBk R T4 license X, 2 55 Gowin i) synplify
1E34K license BHE I . [K 2 synopsys 2= BRIN G BX AN 42 T 4K license, A
RO EREAL &,
PLRRLwin7, 64 f{E RS NBI, B8 RGHELE.
1. {#4F License {4
F3R15 1 SynplifyPro 1] License (44 (U licensefile.txt) {RA77EFE E H
&K, 40 “E:\Synopsys\licensefile.txt” .
2. MEENETE.

a). Ak “UFEA, EE CRaENT , Bl CERRARARE",
T “RGEH” w1,

b). fE“RGEM" T O Bl m A, B R A RS H A, T
AP AREUEAE, WK 3-2 frs, 7T PR B E S
NI 8 4 A AR FAE s
- W EAFR: LM_LICENSE_FILE;

- E{H:License XA FIAF AL E , WI“E:\Synopsys\licensefile.txt”.
3. il “HhE”.

E 32 RETREE
' EmEe 5
iENE [EE BB | Feein me |
HEEE 23
(emr=s =
TR IM_LICEASE_FILE|
TEHE V) E:%Symopsysiilicensefile. tut
[ me | =mE |
N —
FETEE (5)
T8 i8 it
ACTEL FOR_AL. ..
ALTERA_FOR_A. ..
ComSpec C:hWindowshsystem3Ziomd. exe
FFP_HO HOST w1 S
(FEw... | [(®Eo.. | [ #Wo |
= [ ®e | EH | |D
N A -
3.5.2 BRI ANE

ANV IR AR R A 8 — S VAT IE R 5 45, R ) PC #R]
. Bl ATE LA A P BB R
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3 miFH s 3.5SynplifyPro License hn#

1. JBhFShEAIEARSS, ¥ Synopsys Common Licensing (SCL) #
fF, BREAE 223540 R 3% “GowinLicenseServerForwindows\SCL”,

a). B SCL #4734 “scl_v2018.06_windows.exe” i#47 SCL
BAR e, R m PR ede, it E “Site
Information” Fi [ Al BEAT W0 AL E -

- “Site ID”:3k141) SynplifyPro [ License 34411 synp_license.lic)
() “siteid” HJHUE, 4129247,
“Site Administrator”: & AHLE HE 5 4455

- “Contact Information”: WJiEIHI, AR TN

b). SRJEHRAE AT e n) R B REBRAT, WA FEEEAR
“C:\Synopsys\SCL”, miii N—Z HEIHI e A m,
“Completing the SCL 2018.06 Setup Wizard”, /i “Finish” %
H5E R SCL 2%,

2. 1E SCL Z2heigie FHEAF|SCIFIE “2018.06\win32\bin”, 11

“C:\Synopsys\SCL \2018.06\win32\bin”, G M5 =5 shiFsh il ik

MR, LAWIn7, 64 (iifE R4 8051

WSITIER

a). BVFEEhFAIUESCE (40 synp_license.lic) E 3|4 M SCL 223 1%
s

b). ABHF ANV AT UE SCAE R TR EAL A R AN MAC Rt
i
license XA “SERVER hostnamel F8BC12950972 27020”

- “hostnamel” MNAZHKCNANLTFHENLAFR;

- “F8BC12950972” NAHLH MAC Hitik;
“27020” ANim 5, RIEZSE SynplifyPro i ENLE B AT
Bk WEMUE N“SERVER GaoYun-PC F8BC12950972
270207,

SUG100-1.6 11(73)



http://www.ebookee.net/Synopsys-Common-Licensing-SCL-11-7_3446803.html

3 mRHAT 2%

3.5 FHAE

SUG100-1.6

Wageus EUAs Woe e uw Gttty

d).

e).

& B0 SV AT IE SO D snpsimd 2547

M5 SCL #ft:rh snpsimd.exe [I#84%, 1524 license S
“VENDOR snpsimd /path/to/snpsimd” —47, & AN
“VENDOR snpsimd

C:\Synopsys\SCL\2018.06\win32\bin\snpsimd.exe” ;

FFF emd & I,
“path\Imgrd.exe” —c “path\licensefile” —I “path\logfile” -z —s;

N— S

121758

BAT e A R VFRTIE RS, BTSN

Y )5, & log SCHF(log U647 : path\logfile), #fiiA License

T2, Iz, log X2 BLINE 3-4 NE.
3-3 License &% %N log S

uuuuuuuuuu 3

01/28/2019 09:16:06 (sopslmd) Siteid: 29247, Server Hostid: 525400BBABE7, Issued on: 12/18/2018

01/28/2019 09:16:06 (snpalmd)
:l6:
t16:
:16:
:l6:
t16:
:16:
:l6:
t16:
:16:
:l6:
t16:
t16:
:l6:
t16:
t16:
:l6:
:16:
t16:
:l6:
:16:
:lé:
:l6:
:16:
:le:
:l6:

9

WW oW oW W W W w W W W W W W wWw W m W W w0 w0 W w

08
08
o1}
08
08
o1}
08
oge
o1}
08
oge
o1}
08
oge
o1}
08
+13
o1}
08
+13
o1}
08
+13
[*13}
08

(Znnsimd)
(sppslmd)
(spRslmd)
(Znnsimd)
(sppslmd)
(spRslmd)
(Znnsimd)
(gpRgdmd)
(spRslmd)
(Znnsimd)
(gpRgdmd)
(spRsimd)
(gppalmd)
(gpRgdmd)
(spRsimd)
(gppalmd)
(gpRgdmd)
(spRsimd)
(gppalmd)
(gpRgdmd)
(spRsdmd)
(gnpglmd)
(gppgdmd)
(spRsdmd)
(snpslmd)

SLCG: Statistics Log Freguency is 240 minute (s).
SLOG: TS update poll interval is 0. TS5 update is detected by midnight reread only.

SLOG: Activation borrow reclaim percentage is 0.

(Bznnalimd-SLOGE)
(Bsnpslmd-SLOGE)
(Bznpalmd-5LOGR)
(Bznnalimd-SLOGE)
(@znpnalmd-SLOGE)
(Bznpalmd-5LOGR)
(@znpslmd-SLOGR)
{Bsnpslmd-SLOGE)
(@3npslmd-SLOGE)
(Bsnpslmd-SLOGE)
{Bsnpslmd-SLOGE)
(BznRsimd-SLOGE)
(Bsnpslmd-SLOGE)
(Bznpalmd-SLOGE)
(BznRsimd-SLOGE)
(Bsnpslmd-SLOGE)
(Bgnpslmd-SLOGE)
(BznRslmd-SLOGE)
{Bznpalmd-SLOGE)
(Bznpalmd-SLOGE)
(BznRsimd-SLOGE)
(Bznnslmd-SLOGE)

SCL AEEEERN
a). WIEShFRIESCE (40 synp_license.lic) E #1343 SCL 223 1%

b).

c).
d).

s

=== Vendor Daemon ===

Vendor daemon: gppslmd

Start-Date: Mon Jan 28 2019 09:16:06 C5T

PID: 30659

VD Version: v11.14.1.3 build 212548 x64 1sb ( build 21254% (ipvé))

=== Starrup/Restart Info ===
Cptions file used: None

Iz vendor daemon a CVD: Yes

I=s TS accessed: No

T5 accessed for feature load: -NA-

Humber of VD restarts since L3 gtartup: 0O

=== Network Info ===
Listening port: 37814
Daemon select Limeouk (in seconds): 1

=== Host Info ===
Host used in license file: gwlicense
Running on HyReryisor: Not determined - treat as Physicaq

B BN VF AT UE SO B T LA R BN MAC Hidil;
& SO S VF AT UE SO IR snpsimd #5425
& snpsimd #1421, RIS 8447 3 Imtools.exe, S Wikl 3-4 Fi

N
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3 mIR s 3.5SynplifyPro License Jn#k

& 34 SCL B&iR |

LMTOOLS by Flexera Software LLC - X
File Edit Mode Help

Service/License File 1 System Settings | Llilties Sf Server Status | Server Diags ] Corfig Services ] Bomowing I

FlexNet license services installed on this computer

Start Server ‘ Stop Server ReRead License File

) ) ™ Force Server Shutdown
SR ErEeTEE MNOTE: This box must be checked to shut down a license server

when licenses are bomowed

‘Uswng License File: C\ProgramData‘\Mational Instrumentstlicense Manager'\licenses

e). 1EFF “Config Services” T2, ALEM TR, W 3-5 Fik:
“Path to the Imgrd.exe file” : Imgrd.exe SCF T E 42
“path to the license file” : license SC{FFTEE IR 1% ;
“Path to the debug log file” : fin#g license J& £ %) log X1

IR (5 C log XA, ECERTT H P HE— log X4,
[E 3-5 SCL it ER T

LMTOOLS by Flexera Software LLC [= )= =]
File Edit Mode Help

Service/License File | System Settings | Ltilities | Start/Stop/Reread | Server Status | Server Diags  Config Services | Bomowing |

Save Service
Remave Service

Configure Service

Service Name |N|LM License Manager ﬂ

Path to the Imard.exe file |C A\SynopsyshSCL'2018.06'win32\bin‘Imgrd exe M

- —— - — B
Path tathe licensefle  |C-\Synopsys\SCL'\gowin_Synplfypro_54EE753: ronse

Path to the debuglog file  |C-Synopsys\SCLAmgrd log Browse | View '—09---|

[~ Start Server at Power Up v Use Services I™ FlexMNet Licensing Service Required

The HexMet Licensing Service is required for optional
features such as virttualization and trusted storage.

0. MEE, B aliERS, i 3-Frs, 4 “Start/Stop/Reread”
Ji%%, i “Start Server” ,  RI{E R 7~ “Server Start
Successful” MK BTN WATiEdAFE log X% B &SR8
meTh, sidinpE 3-5 H i View Log A] & log SIS

SUG100-1.6 13(73)




3 IR

3.5SynplifyPro License Jn#k

SUG100-1.6

[&] 3-6 SCL [E&} license R H

LMTQOOLS by Flexera Software LLC =] =@ ==
File Edit Mode Help

ServicesLicenze File | Syztem Settings | Utiities ~ Start/Stop/Reread | Server Status | Server Diags | Config Services | Barrawing |

FlexMet license services installed an this computer

Start Server | Stop Server | ReRead Licenze File
i i [ Force Server Shutdown
Edit Advanced selfings MAOTE: Thiz box must be checked to shut down a license server

when licenses are borrowed.

Server Start Successful |

!

JABIRSS VFATIE RS 2 5, FFFRACE RANIHELE LM_LICENSE_FILE 74 1] s Ihn#k

SynplifyPro FaI¥F AT iE. W& 3-Fr:

e FE#. LM_LICENSE_FILE;

e FHE{H: License HFMIfFHAIE, Ww: “27020@192.168.31.33” , Hr
“192.168.31.33” NANLA IP Huihl.

B 3-7 FETERIEE

EEERE =

itEdE (B | B8 | R EE |

WETE - Y
Administrater FIFAFZE D
[ 1
' B
esRrTE (o)
TEE Wm: IM_LICENSE_FILE
TEF V) 270208192, 165, 31. 33
[ = | HEuE |
I =
=8 =]
_DFY_INSTAIL. .. 1
MtiamPath C:"Program Files'Altium Desigme. ..
ComSpec CoWindows'isystem3Zhemd. exe
FP_WN_HNST Wi o
(FrEm. . | [FmEo. . | [ #Eo |
= LowE | B | L
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3 IR 3.6 i JHA Lk T H. License Jn#k

3.6 o/ T A License N#;

Gowin =R 2235 58 15, FT = IR B 2% License #47 check,
iR License A IEAfIEAL TCiEFT HEH4 H Error 32754, W1 3-Fios.
& 3-8 License Error I#7~1E

way Error . e

'8' License check failed, please check your settings.

|

Gowin =R 58 e TR E License (558, ST
1. 77 Gowin =Yg AF 5, fEksA= b, Hii “Help> Manage
License...” , 7 “License Configuration” % I, 1k 3-Fis.
3-9 Manage License i%&I}

F N
\as License Configuration &J

Licensze Config

) Use Local License File @ Usze Floating License Server

Server: 192 . 188 . 31 . 220 Pert: 10559

Apply for License [ Save ]I Cancel

2. PR License {4 EE S License 14

® Use Local License File
1P A M node-locked License S0, #.ii “Browse...” , @IS
R ERAT o
!
W License 4%, #.id; “License Configuration” % 1142 K J5 “Apply for License”
Hid .

® Use Floating License Server
BB AE RS, 74 PnrLicenseServer 3, BRItz 3
£, XA 92“ GowinLicenseServerForWindows\PnrLicenseServer”.
AliE I LA A5 RS 3) PrLicenseServer:
a). ELIEXGE “gwlic_serverexe” JE3):
BB EF S RTIESCE (i gowin_license.lic) & 1%
“GowinLicenseServerForwindows\PnrLicenseServer”, %3¢
AMIE 4 9 “gowin.lic” , X “gwlic_server.exe” ;
b). AT E )

SUG100-1.6 15(73)




3 wIR A3 3.6 i JHA Lk T H. License Jn#k

- HSBEFEhYF IR (B gowin_license.lic) & i F
“GowinLicenseServerForWindows\PnrLicenseServer”,
7t cmd & K gwlic_server.exe FTERE N iy AT
gwlic_server.exe —l license.txt. J&#h)5 a1k 3-Frw.
3-10 Gowin Floating License Server BEIAE

Bl BIER: C\windows\system32\cmd.exe - gwlic_server.exe -| C81F6626CIA5_floating.lic li@é

48 > loading license...

tool: gowin,. limit: 18, expired date: 2016-85-25
48 > starting server...

Host—id: C81F6626C?A5

IP Address: 172.168.31.97

Listening Port: 18559

server started. waiting for connection...

- RBBhEIhZ G, fE‘Licese Configuration” g I i AR 55 2%

(1) 1P Mk, 4 3-6 Froxe.
[# 3-6 Floating License BECE A E

-
i License Configuration I&J
License Config
Uze Local Licenze File @ Usze Floating Licenze Server
Server: 192 . 168 . 31 . 220 TFort: 10559 Test Connection
Apply for License Save | | Cancel |

- sl Test Connection 4%4H 1T LA BE 5 2 1 T, 1%
B T2 1E License Configuration % 11+ H ¥l successed,
ZZ[] 3_7 Fxﬁﬂ—io
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3 IR 3.6 fii i £k T H License Jin#;

& 3-7 MiRERE

Ay License Configuration Iﬁ
Licenze Configz
() Use Local License File (@ Use Floating License Serwer
Serwer: 192 . 168 . 31 . 220 Fort: 10550
Succezsed
1|
fpply for License | Save || Cancel
b i —— e —— = = )
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3 mRHAT 2%

3.7 FAFVFATIE N #K (Linux)

3.7 R IFAEME (Linux)

3.7.1 SynplifyPro License %X

SUG100-1.6

Linux ¥145% 1) SynplifyPro & Floating License 287, 4ii 3]

SynplifyPro [ License J&, ¥ license.txt SCHARAEAE Imgrd 42T, TRELE
HE A T license.txt I, EEBCR 485 B 4%

Linux £ 45 LA 64 4i7 Linux £ 4:, Redhat 5 A T 3 #F floating license

ZAe, HZH U N BERPATINEIE IR
1. 32 “GowinLicenseServerForLinux\SCL\Synopsysinstaller” T,

fR¥E “installer INSTALL_README.txt” Z3E$iR, 224

“Synopsysinstaller”:

a) 7t Synopsysinstaller_v4.1.run CAFERFE R, BECCEFRBRAG LR AT LA
i, G447, 1817 “chmod 755
Synopsysinstaller_v4.1.run”,

b) VI#:Z root AR, 7£ Synopsysinstaller_v4.1.run 4% 4T % % fiy
AR “./Synopsysinstaller_v4.1.run -d /usr/synopsys/installer”.

c) iBiH root BUPR, FfRZFEIATATLMER, 7£ SRS HAT: “chmod
-R 755 /usr/synopsysl/installer”,

I AL &

- 42 Cshell, &17:

“set path=(/usr/synopsys/installer $path)”

- W& Bourne Hij2 Bash shell, Miz47:
“PATH=/usr/synopsys/installer:$PATH”
- “export PATH”

d) TTLLH“export”f5 & &I &, MIMHHIIN PATH 2 B3I .

& “GowinLicenseServerForLinux\SCL\doc” K

“scl_INSTALL_README.txt” 1T SCL i fF%eds, 2 Eu “path/

scl_lic_server_linux/v2018.06”:

a) WHE suse 24, NIMIER “GowinLicenseServerForLinux\SCL” [
“scl_v2018.06_linux64.spf” i, R EHA RS (CentOS,
Redhat, UBUNTU %), NIMIE: “scl_v2018.06_suse64.spf” 14

b) fE% %4 Synopsysinstaller 2 5, %% SCL #fF, #ATM4:
“installer -batch_installer -source <SOURCE> -target <DEST>"
<SOURCE>Jy spf SCF 845, <DEST>H %% SCL HAF K12 .
IR P SRR R B IR 223, AT “yes” 4k
SE TN

A IE GRS H license SCAH:

a) BEGTENLAFR LN MAC Hihik
7t floating license SCfFH, % “SERVER hostnamel
000C293B1A2B 27020” 1% hostnamel &N &% L4,
000C293B1A2B &y HWaddr, 27020 Ay 115, 4 22 %% SynplifyPro
- HNUE BT B8, . “SERVER gaoyun 000C293B1A2B
270207 ;

18(73)




3 mRHAT 2%

3.7 FAFVFATIE N #K (Linux)

b) &k snpsimd %1%
M4 SCL B AFH snpsimd %12, ¥ license 3 A4+ “VENDOR
snpsimd /path/to/snpsimd”—17, B NAM: snpsimd ] #84%, 1
“VENDOR snpsimd
path/scl_lic_server_linux/v2018.06/linux64/bin/snpsimd”.

il SCL Jin#k License:

7E Imgrd 42 N 4T84 /Imgrd -c license.txt -l lic.log”, “ER% log 14

lic.log, &% lic.log LAV IS, Wn#E Y, log SCfFH4

HE A 3-4 NEE.

e B IR &

a) WHEMNEIAE LM_LICENSE_FILE, HAERK%N “im 05 @EM
47 . fn: setenv LM_LICENSE_FILE 27020@gaoyun.

b) License z3EidfEdy, BRINKH 27020 i 11, F 7 7] 4% License #k
e, B R: 77T License S0, 4k “270207 745, K
HAB SR E i

!

H K license MIEAETR 24 AT, FrE 182 391E license 2250 H 3 F AT
e # license—— “./Imgrd —c licensefile —I lic.log” ;

e (£ license—— “./Imdown -c licensefile” ;

e 5 license R “ imstat -a -c ¥ E5@FENL”

3.7.2 Tk LA License jNE;

SUG100-1.6

Linux %5~ Gowin License Jin#d# 5 Windows 355 N IH, 152

# 3.6 fiJmAik T H License f#L.
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4 BYFHAT A S 4.1 bt

SRR PR

Z:?)E’#M#ﬁﬁ}ﬁﬁﬁﬁﬂ 4-1 FiR, i%‘éﬁj\?’\jﬁ%ﬁé\ %ii‘é\ THAE,
THEEHX (Design & AR X (Process & 1) Y5 SO bR X
5 BHH X (Output).

41 RERPAE

) GOWIN FPGA Designer [D:\gcwin,prﬂJect\E5EiM\:nt,S,lﬁxlk,G\srt\tnp‘v] S | B S|
; Hle Edit Jools Wikdow Help AEER

= S &

Desien & x moduls top (clk,clkout,dout); A
input cl
output [7:0] dout:

T
2
3

[E] Gwaar-vislQuaacs17 ||| 2 emutput clkout:
5
€
7
s

- ent _B_16xlk 0 - [Difgovin prow *

@__ 4 [ HDLFiles

wire dout_c;
srcftopy reg ent = 0}
" : 2 —
Frocess & x|| ® alwaysg(posedge clk) =
= 10 Flbegin
7 Timing Constraints Editor ]| | 34 cnt<—cat+i:
4 (O Synthesize 12 Lend

13 assign dout_c = ent;

Synthesis Report 14 assign dout = dout_c:
= Netlist File 15 assign clkeut = clk;

I

4@ Place & Route 16
17 endmodule
Place & Route Report 18 -
Timing Analysis Report « m »
Ports & Pins Report = J Start Page Design Sunmary 4 top. v [x] |
outpat 8 x
Infa (TAD001) : Timing analysis completed. -
Info (FS0001) : Bitstream generation in progress......
Infa (FSD002) : Bitstream generation completed.
Info (PW0001) : Power analysis completed.
Info (CMO00E) : Generate 'D:/gowin_project/BSRAM/cnt_g_léxlk_0/impl/pnr/cnt_g_l6xlk_0.power.numl' file completed.
Info (CMO00E) : Generate _project/BSRAM/cnt_g_l6xlk_0/impl/pnr/cnt_g_l6x1lk_0.pin.ntml’' file completed.
Info (CMD0OS) : Generate 'D: _project/BSRAM/cnt_8_léxlk_0/impl/pnr/cnt_£_16xlk_0.rpt.html' file completed. _
@__1_».:.;_ (CMO008) : Generate 'D:/gowin_project/BSRAM/cnt_£_l1éx1k_0/impl/pnr/cnt_£_16xlk_0.rpt.txt’ file completed. =
Info (CMD008) : Generate 'D:/gowin project/BSRAM/cnt 8 16x1k 0/impl/pnr/cnt € 16xlk 0.tr.html' file completed.
Infa (CMD001) : Mon Feb 25 15:33:41 2019 e

Conmit

In: 16 Col: 9

ST
TRAEKX
FERA R

| outpot [ Temmas |

@ HrmiE

B3 THR

® P EgmEEIX
@ 'quu\iﬂJHjl:

@@@

4.1 FrERt=

LRGN AT RN AR KA RTTT T SR A4 8K

4.2 SRR

T BRI — e S R DL K TR A R 1 S 3 LA, £4FE File . Edit. Tools.
Window 1 Help 3£, PERUIT:
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4 IRPAT L S 4.2 A

1. File SEHpt:
New, Hra XA THE;
Open, FTHCHAITHE;
Save, 1RAF LFEAHHISCE;
Save As..., AN
Save All, {RAFFTA T
Close, <M LfEak#H TR AT T
Close All, SCHIPTAE LM LT ;
Close Project, I 241 T2
Print, #TE[
Recent Files, #&irfTH B304, wTLAEH AT H
Recent Projects, fITFTH M TAE, 7T LAE RS H
Exit, IR H .
2. Edit A
Undo, Jl%H;
Redo, Efif;
Cut, %t}],
Copy, Eifil;
Paste, fhli;
Select All, &4,
Find, 7408 #5085
Macros, 7.
1. Tools ZEHF::
Start Page, FFIH7L;
Convert FDC, fdc 4% gsc T K,
Synplify Pro, Himsra At
Gowin Analyzer Oscilloscope, &z fEZZ T
IP Core Generator, IP Core ;=4 2%;
FloorPlanner, ¥ 4k 4% ;
Timing Constraints Editor, %) 4 iE 28
Options, H ' AI7ESAL BEFT AR R T R % & IDE 4.
3. Window SZHLFE .
Full Screen, 4R &R;
Tile, “PHHERN;
Cascade, 7& i {woN;
Reset Layout, KE WM E
Panels, X 5 H 8 X 3k i 7R A B ) 1 45 5
Start Page, fEJESCHE4m’EIX Lo~ Start Page;
Design Summary, fEJE 1 9m%HE X 7~ Design Page.
4. Help SEHFL:

e ContactUs, BtRIKAT;

e Manage License, ¥FrJiFE ¥,

e About, HARAMER.
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4 VA S 4.3 TH&E

4.3 TH#=

T BRI — T H DR ARV N T, 3N B AR RO S A
B T (New File or Project). fTJF3CfF8 T.# (Open File or Project).
Xt (Save). fRAEFTA CHE (Save AlD. FTED (Print). {44 (Undo)-.
i (Redo). BIY) (Cut). Ei#l| (Copy). Hilli (Paste). & (Find).
Synplify Pro. IP Core Generator.

44 TFEEEX (Design ®§O)

T BRI TR R AR RS B R /R Dh g, 32 B B oR B B AR P
MEEE R R Bt 3CrE . P s AR LB B A 5

4.5 FTEEEX (Process ®HO)

FERMEH P FPGA %1 i, fdE454E (Synthsis) . i Ffhi £k (Place
& Route) LLK F# LA e f (Program Device), [&] A X5 T I 4
FORNY) LR T 23 AT 2R S

4.6 FXHrmBRX
R 0 S T

1E File & FUFT BT H I SCHE 286 J5 A I SCHFE B K Place & Route
JE AR R SO ] BN AE SCA AR X, 41 “Start Page” K& TR
“Design Summary” [FI#fe SoRE AR X .

SR BORTE ORI X N, FEAMEO ST AT T B SURAE, WIHESCAR
GiEIX N3l “File Changed” XFi%HE, Wi 4-2 pis, &% “Reload”
U = T I gk 2 S A

5 H —
4-2 CHERUIR TRE
- . . o _ Reload
' The file "C:\Usersiroot\Desktopil 8IDEitestlimplipnricst. cfg’ changed on disk.
# Do you want to reload? Cancel

Hidi “File” SEHAAH “Close” RN SCASYm 4R X 24 5 SWon A4 A
) 3, 256 P SCAS S A X PN 24 i o ST
By “File” SZEF:LT “Close All” 3ET0, NI 45 P SCAS g 45 X N S 1Y)
F SO
4.7 EEWIEHEX

BRI AT SR A BEE,  ATFEh bR A AN R SR 1 4
GAEPSE

o A{FE U1 (Output 71
e |1F ZHE T (Issues M)

£ Output & LB A5 58, k3% “Clear” , Ali&E = THI{E R Issues
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4 ZIRHAT T S

4.7 5 Bt X

SUG100-1.6

JUELE Warning #1 Error PAANFET0, Al 454 Issues TUTH A {27~ warning {5
B8 error (515, AR ER IS B IR A1 5 I Warning B8
# Error BN INE 4-3 Fion. 1E Issues & LB A4, k% “Clear”, #J
T AT DU S B

43 EEMERE
Dezizn Process - Start Page

I=zues

2o /0o ]

1 BR: multi 2rs gen output is up to date. No run necessary.

I @A: MFB827 |No constraint file specified.

I BW: FX474 |User-specified initial walue defined for some seqguential el
I, BW: MT529 :"d:\gowin projectibsramicnt 8 1éxlk O\srchtop.v":10:0:10:5
I @W: MT420 |Found inferred clock top|clk with period 2.02Zns. Please dec

< |

Output I=zzues
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IR EER

ZUREATSZHF Windows AT Linux AN RAS, HL S35 5 AR AONT i 24T
HXJ&1T, LA Windows fiiAs, FEizir afl, S8t mse k.

5.1 FMEILiz

1. Hi “File> New...” , 4TJF “New” %I1&#E, & 5-1 Frx.

5-1 ¥ T2
rw MNew u—J@ - ]
4 Files i

_\.} Verilog File

g VHDL File

m

|y Physical Constraints File

¢y Timing Constraints File

Loy GAO Config File

ey GPA Config File -

s e

E!

JRAE PUR = M7 3 TF “New” XFHEHE:

o fHEAITRIERE Ctrl+N;

o HF T HF L “New File or Project” E#x;

e Iil; Start Page 51 - “Quick Start>New Project” .

2. %F “FPGA Design Project” , i “OK” , FJH “Project Wizard”
@, Wi 5-2 s

SUG100-1.6 24(73)
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E 52 HETERS
U Project Wizard =

Project Name
B Project Name

Enter a mame for your project, and specify a directory where the project will be stored The directory will be
Select Device Py

created if it doesn't ex

Sunmary

Fame: fpea_project 2
Create in: D:igowin_projestil. 9.0
[]Use a= defsult pesject location

3. QI TR, WK 5-2 fis:
c). £ “Name” SCAMEHHAN TS
d). iy ‘L ERETERR.

B
o BRMAN SR AT BARRAE AN SCRFE A O RS SRR AE, BT AR B AR TR R
A SCEE RS

e  Windows Al Linux IS0 EE A IR T, TEREAE AR KRB H R4
PRI RSO, MBRECE 3 DU AT ET 2 2R

e 5 Linux A[F, 7£ Windows FE&Z5 A “\” , W1 E\Gowin\ide;

o ik “Use as default project location” , Bl 2ki% TR EAE X B NERIN KT,
UG LR BN LR QI AR 12 B84

4. Hiy “Next” , WE FPGA O HAS, WK 5-3 E FPGA &S
FioR o

® 7t “Select Device” FEi%HiL#E “Series” 1 “Device” ;

e {f “Package” THi%lFH ks,

o {f “Speed” TFHHIFKFIELPEEEFN;

® 7t “Part Number” £ ik HF R A& MAS, I HiZEF ERITIERES AT

FEAN GRS S

SUG100-1.6 25(73)
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& 5-3 % & FPGA B /&S

SUG100-1.6

i Project Wizard

Project Hame

E Select Device

Select Device

Specify a target device for your project

Filter
Summary
Series: [GHIN v| Devicer  [GH1N-4 -]
Package: [EBGAZSE |
Spesd:  [CB/IS -
Part Number Device Package Speed  Voltage IO LUT FF
gGWlN-LVdPG255CEu’|5 GWI1N-4 PBGAZ256 CB/15 v 207 4608 3458
GWIN-UV4PG256CEa/15 GWIN-4 PBGAZ56 Ce/I5 uv 207 4608 3456

4 I

Hext >

5. B “Next”, £ “Summary” k&8 2T FPGA T TS
n_n&‘b‘}ﬂl"fl:l ARy ﬁl:]lg] 5-4 Fﬁ%o

[EH 5-4 :I:i%E{éian

A Project Wizard

[S5)

Project Name
Select Dewvice

B Sunmary

Summary

Project
Name: fpga_project_2
Directory: D:\gowin_projectil.9.@

Source Directory: Divgowin_project)\1.9.8\fpga_project_2\src
Implementation Directory: D:\gowin_project’\1.9.@\fpga_project_2\impl

Device
Part Number: GWIN-LV4PG258CG/IS
Series: GWIN
Device: GWIN-4
Package: PBGAZSH
Speed: C&/IS

6. Hii “Finish” , THEAIE .

y‘fl
o LKA

SHHOE LRGN E L FBN HAE RIS

T.7% Device;

o LREFTH MRS KA FR SO FAE TREGVE 2 )i in, VRS B

F£>5.3.2 gt TR

22 5.3 fiE 1LFE>5.3.1 5%

2% 5.3 YilE L.
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52 ¥ 12
I AT B A AT OT SR R s s R TR, A AT PO
77 A JTIF TR
TiE—

1. SEHFLH, % “File> Open ...” 7T “Open File” XH&HE, &l 5-5
Fi7m o

Varll ]
#E!

JRAE R T RAE R ¢

7 Ebr, FTFF “Open File” HEHE.
55 yTHAIRE

{4 Open File &J‘
QQ | , « FEHIEEE (D) » gowin_project » 1.9.0 » fpga_projectl » - |6,| ‘ HEF foga pro, P
E=Eaig TR = 0 @

r v 5 B ) ] ]
5 FE . impl =3
M = = re /2]2 prat =
A E S | fpga_project_l.gprj 2019/2/28 11:02 GPRJ i 1KB
19
. gowin_project
= =
1 HEE 1
SHEE(N): fpga_project_Lgpr - [A” Files () (%) ']
T

2. %# “Open File > T (*gprp) 7, Hidi “Open” , T L.

HEZ
1. f£ “Start Page” T, H.di “ome 7, FTFF “Open Project” X1
1,
2. “Open” , fJHIFE.
HE=
S, ik “File> Recent Projects” , &£ T 4T F I THE.
!
e JKH[{E “Start Page >Recent Projects” &, EFEFHFITH I TR,
e  “Recent Projects” AT IL 1 TREFIER;
[ ]

HiZ LR M, <3 “Open Project” #&/~HE, WK 5-6 Fix

SUG100-1.6
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& 5-6 Ti2MIpRiRRAE

r'w Open Project @1
Can not open project "Dgowin_projecti1.9.0\doc\doc.gpr”
R R,

papr L]
FEAIFR B TRE, 48 LRI TR F.gpry, Ry TRESCHF
At B s ST TR
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5.3 YmiE 1=
BT LR, I/ LB XN FPGA L2 S B AL
P T 9w A, Wk 5-7 Fias.
THEEEX FTEAEITNER:
e FPGA LHEMBAEER;
o [FHMGHER: BHMS ., H3770E ),
o Ui LEGUEMXER, SR &I . W2 (est).
P20 5R S (sde)s GAO B & X (.gao). DhFEsr#T GPA it & S

(.gpa) %.
& 5-7 TEXHEO
Design A X
4 fpza project_1 - [D:fgowin_projectfl.Q.U";

[ﬁ] GWIN-LVAPG256C6/15

4 HDL Files
srcftopw

4 Physical Constraints
src/fpga_project_l.cst

4 Timing Constraints
src/fpga_project_l.sdc

4 GAQ Config Files
src/fpga_project_l.gac

4 GPA Config Files
src/fpga_project_l.gpa

Tesign Frocess L

5.3.1 ¥ T2 Device

FE TR PRIX EE —AT WA e AR R 21T FPGA TR HI RS 15
E

PIARS

1. K 5-7, Wii “GWIN-LVAPG256C6/15” , 17T “Select Device” %
M, WK 5-8 fin;

2. 1t “Select Device” % I H1iE$ “Series” #1 “Device”, 7t “Package”
ThiA RGP A, £ “Speed” THiARPEFEEER, &
“Part Number” #iE# BAARRIRS, MBS §T TR AT H 1 Device

55

¥

“Part Number” #2 b i 7R Bride & F I VEGH B2 5 2.
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% 5-8 TI2ELE Device 58

'w Select Device — " m‘
Filter
Series: |GHIN 7| Devieer [aim-4 -]
Package! |Any -]
Speed:  [Any -]
| Part Number Device Package Speed Voltage 1O LUT FF S-SRAM B-f
GWIN-LVALQ144C6/15 GWIN-4 LOFP144 C6/15 v 119 4608 3436 N/A
GWIN-LVALQ144C5/14 GWIN-4 LOFP144 C5/14 v 119 4608 3456 N/A
GWIN-LVAMG160CE/15 GWIN-4 MBGA160 C6/15 v 131 4608 3456 N/A i
GWIN-LVAMG160C5/14 GWIN-4 MBGA160 C5/14 4608 3436
---
GWIN-LVAPG256C5/14 GWIN-4 PBGA256 C5/14 3456
GWIN-LV4PG256MCE/15 GWIN-4 PBGA256M C6/1I5 v 207 4608 3456 N/A
GWIN-LVAPG256MCS/14 GWIN-4 PBGA256M C5/14 v 207 4608 3456 N/A
GWIN-UV4QN32C6/15 GWIN-4 QFN32 C6/15 uv 24 4608 3456 N/A
GWIN-UVAQN32C5/14 GWIN-4 QFN32 C5/14 uv 24 4608 3456 N/A i
4 (1] | +
0K Cancel

5.3.2 BT

TREFR TN SRR R P RTL %t 30F (Source Files). £
AR E SO . HoA, AR B R S (Physical Constraints
File). I F£3 4k (Timing Constraints File), it & X {H 45 GAO Bt & X
4 (GAO Config File). GPA it & 3 #f (GPA Config File).

TARERI S 2 P et 3o, EACRT RS M EZ RO A A
FPA RS

48 U e G 88 TR P 7 DA
1. FrE TR

2. W 5-9 fian, £ TR HE X 25 (A Ab s B b o/ 28, 16 9% “New File...”
FIIFH S0 New SHEHE, Gl 5-10 Frws

3. EE5-10 7, EHFFH RSO,
E 5-9 AEsEy

De=ign = X

F fpza_project_1 - [D:fgowin_projectfl.g.El"i
GWIN-LVAPG256C6/15

Mew File...

[ Add Files...

SUG100-1.6 30(73)
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& 5-10 FiE 4R m

W New ? x

~ Files

O

(2)——+— [ & VHDLFile

3) g Physical Constraints File
g} L. Timing Constraints File

S — . [T R

W2 |_gy GAO Config File

(6} |_& GPA Config File

(}" 1 _: ¢ Memory Initialization File

Create a Verilog HOL file.

) e o

o [ cance
@ Fi/" Verilog ¥t 3ot @ FIF* VHDL ¥ 50t
G) WL @ wFELFE
(G GAO fit B (& GPA it &1t
@ HLA7 BRGSO SCAE KRR X

4. WK 5-11 Frax, LAETE Verilog File 9, & “Verilog File” 37715t
7 Verilog File % .

& 5-11 $# Verilog File 2@

-
wr New Verilog file

Hame: tast
Create in: C:hUzersiroothlesktopil. 8I0E Y testhisre

Add to current project

5. HEMF4, Hidi “OK”,
!
o HNEFECIHY M, BRi\Aik “Add to current project”.
o TIYEVESCHRgER X AT R A S0, RV T g

6. BT E S

a) W 5-9 ffion, # TRAEEH XS A md Sbr A, %8 “New
File...” , FTHH & 0 New XiEHE, W& 5-10 Fis;
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b) 7EK 5-10 ', EFFTHERACE TSR, LUEiE GPA Config File
i, xR “GPA Config File” T i GPA Config File % 1, 1
K] 5-12 7
C) WML E MRS, Ao EEAEIE SO e X T I8 g s A E S
A LR B X OO B B S, DA 4T S B E S, AT
Ynik, WK 5-13 FioR.
B 5-12 FiEREXHRE

{4y New GPA Config File l T |

Hame: tast|

Create in: C:\Users‘root'Documentshfpga project_1Z4sre Browse. ..

0K | [ Comcal |

5-13 GPA BRE st

General Setting | Rate Setting | Clock Setting

Device

Device: GHIN-LVOPGESECE/IS

Operating Condition: COMMERCIAL - Process: TYPICAL -

Erorirorment
Ambient Temperatuwre: 25.000T |4 -40°C-100C)
[7] Custom Theta JA: |25 000/ |

Heat Sink

@ Home () Low Frofile () Medium Frofile (0 High Profile () Custom

Custon Theta SA: 250004 |

Board Thermal Model
@ Hone Custom Typical
Foard Temperature: |25, 000°C (-40°C-100°C)

Custom Theta JE: |25.000°C/A% [

Voltage
VCC:  1.200% |5 (1 14V-1 26¥)

VOO 3.300% 5 (2. 37SV-2. 725V or 3. 135V-3 485V)

= Start Fage [E Tesign Sunmary o GPA Comfig ¥iew B ‘

o W AN Verilog File 5 A S E 4, WIGEGRN, FHordidn, Wik 5-14 A
7N

o NI LR SCHAE TR U CEAEAE, SRR Toikamm, Wi 5-15 Fir,

o NI B SO TR P B2 A7 A, SR EiEw N, K 5-16 Fix.
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E 5-14 ERER

-~

Wy New Verilog file

=

Hame: test
Create in: C:%WUsersroothDesktophl S8IDE%testhsre

#dd to current project

)
[ Browse |

Browse. ..

File test. v already exists. ] [ Cancel ]
5-15 TR ME—1
W Mew Physical Canstraints File ? 2
Hame: test .est -

Create in: D:'gowin_projectil. 9 04%fpza_project_lhisre

D Add to cwrrent project

File test. cst already exists.

Browse. ..

0K

Cancel

[ 5-16 BELESCHFME—1E

Wy New GAQ Config File

Hame: test

Create in: C:'UsershroothDesktophl. S8IDE‘testhsre

File C:/Uzersfroot/Desktop/l. SI0E/ test/sreftest, gao already exists.

Browse. . .

| (et ]

7. I TR

el 5-17 s, ETREHEX T AL, fliblisa, % “Add

Files...” , FT7F “Select Files” XfiHHE;

8. IEFF TR, AR RS A AR BCEBA SN, SE A in i

B ELE
!

o VRINSCHFNY, FE “Add Files...” , WRIRINSCHER R TR SO ST
FRE BB EHE TRAS, ET TR, 0 518 Fis,
o IR RTL SCPE. SOOI, P S LR B DOR SO 7 53

%;
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o WRIINAISTAFEEAZ RTL Bt XA R L H ST GPA. GAO Bt & X1,
M 7E TFEE H X 2380 —AN 04395 “Other Files”.

5-17 Design WO AEEE
Dez1zn g X
: 4 fpga_project_1 - [D:J‘rgowin_proje"'é

GWIN-LVAPG256C6/15
4 HDL Files
sroftesty
4 Physical Constraints

Il sroftestd.cst

Mew File...

[ Add Files...

Procass |

& 5-18 XHEFHIE TIRREFIRRIE
"G Add files . [ |

& These files are out of this project’s source directory.
=" Do you want to copy them inte the source directory?

Erworkifloorplanneritop3.vm

%

9. BRI
.l 5-19 fra, Al LT PRy AT S0

a) Mt TREE X A B —SCfF, 75 9 B SO B2 Sl R AR IR G
X
b) ALy i EAB LS, Hidr “Open” o

SUG100-1.6 34(73)




5 mIRHATAEH

5.3 4iiE T2

SUG100-1.6

B 5-19 T miEsey
Design F X
4 fpga project_1 — [0/ gowin_projectf1. 9. O

GWIN-LVAPG256C6/15

4 HDL Files
| = srcftesty
4 ! Open
Open With... 3
“ 1 Open Terminal Here
Open Containing Folder
a
[4 Remove.. Del
4 Enable
Disable
] Mew File...
[% Add Files...

Dle=sign Frocess

%4 “Open With>Add External Editor” , A s INE#E kB AMBgmi g i 11, 1A 5-20
Fizs, PR RRAE B B 48 SIS I G 4 25 5

e ik#% “Open Containing Folder” T $TFF SCF e () S04
e ¥ “Open Terminal Here” RI4THF i &ATi247 % 1, H P nl@ddr 4780217
o TSNS AR SN DAL S URPE i XTI B SCHE BUR IRAF 2 5, Gowin =
VP AE 2P TR HEE A, i 5-21 s
P R A G JE RORAEIISCAE, IR S5 TR SRR AF I8 A, Wi 5-22 FoR .
lg 5-20 9l~*|3£ﬁ$3%§
@V Options ﬁ.‘
External Editor
: 7% Environment External Editor
= D Mways Use External Editor
== Text Editor
Name Program Arguments Add
, SR & notepad+~+ éD.;/Pngram Fife.yNofepa...é %f Remove
(:-, Synplify Pro . : Malke Default
[#]items request restart program [ 0K J [ Cancel ] [ Apply
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E 5-21 TIEXHEERM
' The file "C:\Wsersiroot\Desktopil 8IDE\testisreitest. v’ changed on disk.
) Do you want to reload?
& 5-22 T2 HRFAFIBA
W Save &J

Save changes to "Di\gowin_project\1.9.0\fpga_project_1\src\testy” ?

l -.\

oK H Discard H Cancel

|

10. MR TR
a) IR TR H X N I SO
b) i WA, %% “Remove” ok E{E1kiEAL “Delete” #, 7
“Delete File” X[i&HE, 41&] 5-23 fizn . ik “Delete Permanently”
SIEHE, SO ST CARMIBR B AR E IR, 500, 30N

MR AR R
[ 5-23 3CH-BREEIA
4 Delete Files 2 e |

Do you want to remove these files:

Diuser-bak\Users\root\Desktop'1.8.11DE\IDEOT06\src\[DEOT06.cst

[ Delete Permanently ]
L

vE!
YRR 24 A A AR X SO, P S5 SO A, W] 5-24 Fs
[ 5-24 SCH-HIRRIE

E It
] The file "C:\UsersirootiDesktopil 8IDE\testisrcitest. v has been removed on dishk.
H

1 1t7
b Do you still want to keep it?

11. T4 Enable/Disable ThRg
E TAEE B X NI — SO b s B, 3 IR AE 4 Enable 1 Disable
&I, 4P 5-19 fiizr. Enable / Disable %% )5, Synthesize o Place & Route

et IEMZEL enable SCHIT N 25

a) A B R IR B ) Enable / Disable (45 5 Sz 14 %
B E R ED;

b) kb Z A cHE Chdlfiles) I, Enable Al Disable #5] F ;

c) X TRl —Fh LY SRS SO B B 2R S, 1k 2 AN, Enable ATTH,
Disable 7] H|, W 5-25 fr;

d) StFR—FL R EE I, TR R NS0T
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Enable IRZS, FHTEBNINES, 280 — N2 SO e id & S
Disable #5i; ik Z /NS SO, Enable fl Disable IhfE
AR H, K 5-26 Frx.

5-25 RSP EI BT HARIEE

Design x| 1

4 fpga_projest_| - [Di/gowin_projes
[ﬂ GWI1N-LV4PG256C6/15
4 HDL Files
sroftesty
sreftop.v
4 Physical Constraints
o
sreffpga_project_2.cst
- Timing Constraints

X

sreffpag_project_3.sdc

Ev]

Open
Open With... »

4 Open Terminal Here

Open Containing Folder
| & Remove.. Del
Disable

MNew File...

¢ Add Files..

& 5-26 £ BN FRIREC A RIEE

Design 8 x |1

4 fpga project_| — [I:/gowin_proje
[#] GwinN-1vapG2as6CE/S
E HDL Files
srcftesty

srcftop.v

- Physical Constraints

e
Open

4 .

Open With... 3

Open Terminal Here

VS VY

Open Containing Folder

-l

| & Remove.. Del
a !
New File...

a {Lg Add Files...

src/foaa oroiect 1.aba Il

5.3.3 £t TIEE &

7E TR HLIX N 1) Synthesize 4b 5K Place & Route 4b, i fbR 47 8
1. &#¢ “Configuration” , FTH TAERCE BT, WKl 5-27 fis.
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E 5-27 THERCE @

W Configurations

4 Synthesize
General

4 Place & Route
General
Dual-Purpose Pin

BitStream

Synthesize
General

Synthesiz Tool: @ Synplify Pro () GowinSynthesis

Top Module/Entity:
Include Fath:

Synplify Pro

L)

Category: |11 -
Label Value it

Frequency Auto E‘

Use Clock Period for Unconstrainted 10 False n

Fanout Guide 10000

Disable I/O Insertion False

Update Compile Point Timing Data False

Read Write Check on RAM True

Annotated Properties for Analyst True i

0K ] [ ] ] [ Apply

JE DL K BitStream J& 1k -

WK 5-27 fiis, AIECE R TR RS Synthesize JE14AT Place &
Route J& 1%, Place & Route J& £ X 4% General J§ 4. Dual-Purpose Pin

Synthesize: H T & Zi& THALMWH P8t o & K288 1%

General: HTH BT RAALN S HE R,

Dual-Purpose Pin: Tt & ik Device 15 B 25 77 20 B (1) 1/0 15
B, FEHTEESEHEM;
BitStream: FT-Hc & 74 [ BitStream {42 7 foVF CRC K46, &%
FE4 LR S &
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ARATACE & TRERIERAHT .
Synthesize

TAEMCE F i, EHE Synthesize EMETT. £ General Fr25 TN, LAk
# Synthesis Tool: Synplify Pro 5i# GowinSynthesis.
% ) Synthesis Tool 4 Synplify Pro:
e 1] LI#E5E Top Module/Entity I Include Path #§4%
e {f “Category” THFIRFIEFESEALE LTI, BRI “ALL” ;
e {f “Lable” ZIEXHEFFRLEN S AR, “Configuration” 7 [ JEKHS
VAT INEA RIS
o NUhPHAMEZHN “Value” 1, WHETFRKACE, Hd “Apply” , #f
EYRTECE AR, JFTSeficE; Hdi “OK” , SERMTAILE .
!
o XTHWHSHRCEIED K E X, ES%5M 5 A SynplifyPro J& % X HE7R;
o  CTATHEEMVEAAE, BT 2% Za 238 H & T SynplifyPro #H2¢3CRY,
%1% installPath\SynplifyPro\doc;
e Resetall to default: *4H{iHC & 5L 4Pk E BN R B, 753 H Reset 1271,
Wk 5-28 firR.
[ 5-28 Reset I=7~1E

[ Ay Reset ﬁ1

Are you sure to reset all options to default?

| ok || cancel |

R EFEH Synthesis Tool v GowinSynthesis, 1X 7] LA 72 Top Module/Entity
A Include Path #%4%.

Place & Route

Place & Route H 1] General it & /& = = M7 H £ R AT & IR
) JeB LT & 0 H , \T7E Value B 15 oUs T, BAR 8 M2 i 5-29 B .
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& 5-29 BLER EH&EM

,
i Configurtions =

Place & Route

o
o e — b A

General .

4 Place & Route Label Value
General @—-Generate SDF File False
Dual-Purpose Pin @ Generate Constraint File of Ports False
BitStream @— Generate IBIS File False

@ Generate Post-Place File True
@‘—Generate Post-PNR Simulation Model File True
@ Initialize Primitives False
@I— Show All Warnings False

8 Generate Plain Text Timing Report False
@— Run Timing Driven True
@ Use SCF False
@I— Not place register to IOB False

@_ Do mot place register to IDB in implement.

0 | [ Cemcel |[ soply

FEAEIT 47 B SDF S0
A IBIS At
P SR AR S A

P4 Port Z1 R SCF
P AR AR R A

Jei 1 BRI SO rp i
BT BRAAYI G
P AR SIS PR
A

® @O

4 BT A Y Warning {5 2

{# ] SCF (14
JE M R R X

i&47 Timing Driven i %
A HHTBCE I 2 A7 2 AT
BHF 0B I

P @ ©WO

Sl

=
Reset all to default: 4 i fc & 71 4K BRI E .
Dual-Purpose Pin

Dual-Purpose Pin Bt B & &m0 eflinE HE W E, A
T H 4 5-30 fioR .

SUG100-1.6 40(73)




5 mIRHATAEH

5.3 ZwiE T2

SUG100-1.6

-
E 530 il ESAEMNEM
-
Dual-Purpose Pin
4 Synthesize [[] Use JTAG as regular I0
General |:| Use 55FI as regular IO
4 Place & Route [7] Use MSPI as regular I0
General D Uze READY az regular IO
Dual-Purpose Pin [ Uze DOWE as regular I0
BitStream |:| Use RECONFIG_H a= regular IO
[T U=se MOIE a5 regular IO
0 | [ Cancel | [ pply
N
!

SR BN E T ITAG A1 JITAGSELN N H R % &, R 24 A2k ITAG & I,
ZRIANE R JITAGSELN B, 423k JTAG &, MERAAREFE ITAGSELN & .

BitStream

BitStream Ft. & 2 /45 5

RS, HARECE & L 5-31 Fiw.

Zon A TR bitstream SCHAE R LA T #E
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& 5-31 BLE LR B

BitStreanm

4 Synthesize te{ /] Enable CRC Check

=] Enable Compress
{] Enable Encryption (only support GH2A)

General
4 Place & Route

Genasal = Key(Hex): |00000000-00000000-00000000-00000000
Dual-Purpose Pin =
==V Enable Security Bit

| BitStream =2
r={V] Print BSRAM Initial Value

e | Background Programming
==Howrload Speed (MHz): [Z 500 (default) Y

==SPI Flash Address: OOFFFOOO0
e ISERCODE : @ Default () Custom | 00000000

eeBitstream Format: @ Text () Binary

@?@?@?@?@?@

L [1):¢ Jl Cancel ][ Apply

@ CRC KI&AdRE 2 4tk

Q) g (AT GW2A) @) HIJ HEE U

OREZ&E X Tz ® ¥ BSRAMWIATHE
5 N bitstream
4

@ mRETHK TSR

(9 SPI Flash Hitl: FA P E e X User
Code

D R SO AR
vE!
SPI Flash #shik 248 ~ — X multiboot i, 1n#K bitstream SCAF-AIALIGHLE, BEARTT S5
Gowin Programmer /4 /1555

54 BTz

ERRREHEX, JIH T mm s IR S DR, WK 5-32 P
FEIZ BT FUAT AT BN #4F

1% Design HEiA ;

JA 3l FloorPlanner;
E@Hﬂ‘?é’ﬂiéﬁiﬁ%ﬁ;
PATLEE IR
BEGERITR
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® T R

® 7rF Place&Route J 14 il & ;

® JHZE &Y 3k FPGA JafEds 5T Re .
& 5-32 T %2 Process B[

Frocess g X

| | Design Summary
4 [} User Constraints
|+ FloorPlanner
o Timing Constraints Editor
4 S Synthesize
Synthesis Report
Netlist File
4 | Place & Route
Place & Route Report
Timing Analysis Report
Ports & Pins Report
Power Analysis Report

|} Program Device

Design Frocess

5.4.1 Design Summary

BrER TRERS, ot TGRS G B —hikd, W

5-33 i, A =FhJ71%4TFF Design Summary:

e i GOWIN FPGA Designer S #.4% I, #E# “Window> Design
Summary” ;

® 1t Process %igH, X7 “Design Summary” ;

® 7f Process @&, HiiArti 8, £ “Design Summary” ik
“Open” .

5-33 TRRERETR

Project File: D:h\gowin_project\1.9.0\fpga_project_1\fpaa_project_1.gprj
Synthesis Tool: SynplifyPro

Part Number: GW1N-LV4PG256C6/15

Series: GWI1N

Device: GW1N-4

Package: PEGAZ256

Speed Grade: C6/15

Core Voltage: LV
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5.4.2 User Constraints

User Constraints $2 4t 7 Pl T Al 29 iSRRI 7. A RE R S
WAWVEMME T, 1625% Gowin i/ 20K 715 -

User Constraints 4> FloorPlanner #1 Timing Constriaints Editor .

Y 2 TR % 4 2% FloorPlanner 1 5 3%

SUG100-1.6

1.

Varll ]
*E!

Xt “FloorPlanner” s ff 47 B SR IEFE “Run”, 2R TR i R 24T
grty, MZBHRoRHE, Wik 5-34 FiR. 458 e Xl
“FloorPlanner”s{ 7F 47 88 32 F % 22 Run "4 & 3T L 24 R Yn 525 5
I B R g as iy, 27 TRER A E 2 s S Cest), guiEds
2 H LA RSO DA Y

HIF RS, WRIEPEEHIMEAR S Cest) RAT AL,
TEVE A g i X AT T 1B /A7 S5 , st FloorPlanner H1 (¥ reload

s SAHMEUS 120 3R SC A BT AT SR EL
EI%EEPT@Q?FBF“E’JQ’JﬁI#F ZE-4 Tl JG Wi FloorPlanner,
P B R A R SR s, anlEl 5-35 Fis
o LR AR S A0SO, BV SC B 3 NS TR 4 2R 3
4 C.cst IFF) B, BRI SEE R N — NS TREE AT
LIRS, A 5 E K Warning $2~4E, W1 5-36.

W iEFE “Tools” ZHLH “Floor Planner” 1 “Timing Constriaints Editor” , 7 H4%
FT7F Floor Planner i[5 2SR gm# 45, 10 AN AT BT SO I 2R B 48E
5-34 TR EGRR

-

w Warning ﬁ
l Please run Synthesize first.
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SUG100-1.6

& 5-35 BB L RICHHR R

&

L%

-
wy Constraint File I&

This project doesn't include CST file(*.cst), do you want to create a default
one?

OK ] ’ Cancel

5-36 BIZL)RICH Warning 27~

-

Wy Warning @1

There is already a default CST file:
"Dnfgowin_project/1.9.0/fpga_project_1/srcffpga_project_l.cst”, do you
want to override it?

| ok || Cancel

B4R ¥m488% Timing Constraints Editor {54!

Wit “Timing Constraints Editor” s 7E 4 52 ik #E “Run” , WIR T2 M ARFAT
ZRE, M 25 2R AE , W1 5-34 FiR 256 i) Ja At “Timing Constraints Editor”
R AR IR “Run” KBS T R LA R gniE % ;

FIIF LR Gt sy, & TP AER TR (sde) , ZZEMRYIE, wmiEataH
UL ST LA S

o LARRANEL S AR B 2T SO, Rt 2 s B 20 R SR 0, an ] 5-37

N
o LR AR S A, B H R T AAES TR MAFR A (sde 3L

) B, TR SRR H A — NS TRERLMAR S, 25
B 5T N Warning #75HE, 1/ 5-38.
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[ 5-37 SR F L RICHRR
rv.:,r Constraint File ﬁw

This project doesn't include SDC file(*.sdc), do you want to create a
default one?

OK ] ’ Cancel

b

5-38 B EBTRFLIRICH Warning 127~
rw Warning ﬁw

There is already a default SDC file:
l ~  "Difgowin_project/1.9.0/fpga_project_1/srcffpga_project_l.sdc”, do you
want to override it?

Ok ] ’ Cancel

5.4.3 Synthesize

AT Synthesize b} = R R LM R& TR 4TRSS, Synplify Pro
A1 GowinSynthesis, WIRANEATIERE, BRINLZES T HZ Synplify Pro.

AR TR FRIX ) SyntheS|ze Ab Hp. s SRR A8, 2 “Configuration”,
I g6 BB B TUE R4S T H, Wi 5-27 Fir.

Synplify Pro j& Synopsys ‘A f] i 2= 2 AR 1 1 5E hil (0 11 3 25 2 3 AT
SRRz 2 AR ) RSO B LS, SCRF VHDL. Verilog 254 15

GowinSynthesis Fem PR IERE AR, SRR = 2 AR EE SR S
LI, H AT A SCRF Verilog 2R iE S

Synthesize $&fit TIE1T7 45 A W B 456 B S EU & H# M K S (Netlist
File) &% (Synthesis Report) HIThRE.

%% DL B IRIZ4T Synthesize:

BiE Synthesis J& 1, £5& T.21%4% Synplify Pro 2{# GowinSynthesis;
1 5% Synthesis B E, i55% 5.3.3 B LA E
1217 Synthesize;
EFREEIX, Xidi“Synthesize” 8 4 8 H.d7“Synthesize> Run”, J33)]
Zra THRXNE S AT 256
LLRA R, U Synthesize #2474 HILEIRR ¥, 75 IR @
5. ZRAMIIE, Wik “Netlist File” jfiﬁlﬁﬁiéﬁﬁiﬁ% Open &1, Al &FE
WA, AR R S AP S TAE A PR [ .
!
o HIFHZAT (Synthe3|ze ElE A =) Sk “Netlist File” sk7e i35 47 ik 1% Open
I, Wt aia, SRa IR IR SO

bR
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o FHuF&Z AT (Synthesize s A =y ik “Synthesis Report” B1E1Z 4 ik
% Open i& T, W&Jei TG, LA IFaaMms .

FigE s “Synthesize”, WKl 5-39 FIHET HERAERL S
® Run: HA Synthesize RATIEIEN <. @k ¥ 1, Iz
Ja s G T RXR ST 456

® Rerun: Eit Synthesize RFTFURA, EFZLT, EHEHLEA
TR ST S

® Clean: JEMRZEA Jar=4 X fFJ (synthesize) T HIFTHE SIS
I

® Configuration: F %} Synthesis 1 Z¥iE4T % & .

& 5-39 A E “Synthesize” BER

Process g X

|| Design Summary
4 [} User Canstraints
| FloorPlanner
% Timing Constraints Editor
4 <5 Synthesize
» Run
{_* Rerun

a Clean

o Configuration

Ports & Pins Report
Power Analysis Report

w .
i Program Device

5.4.4 Place & Route

Place & Route LIS 1T R Lk BB AR R 28 S50 % B BEAT R A 4k
Ja A2 O R DI RE
!
Place & Route &k T2 &k #2, AT ZZ IR, WHAKH I (Synthesize) K47, M%
Je AT Synthesize, FHUTIZATE.
7% DL N IRIZAT Place & Route:
1. B E Place & Route &1
*F Place & Route JEEALE, 155% 5.3.3 B LIERE;
iz47 Place & Route;
Wifi“Place & Route” B ilAnfi 5 “Place & Route>Run” #4477
JRAT e A4 bit FLSCHE AR R 5 S0 . anis T R, W Place & Route
RERT 2 BB bR, A5 H IR @
5. Place & Route iz47 %15, £ Place & Route I J7 M i S04 oA ik 4%
“Open” A {E A G X Y 2 A

R
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6. A AFARKIIFCE, FE Place & Route Report. Timing Analysis
Report. Ports & Pins Report /% Power Analysis Report, X JYff ({1
ANE] G
!

o IIMETCAATIFIRG M, His4T Place & Route AL ik 15 S R SRR 2 T
BB A

e  #7iz{T Place & Route Z 7l (Place & Route 2R bR © ), Xkl CfF ek
ZARE A ISR “Open” &I, W£x5Ei21T Place & Route, 1217 ML) JE 1T
FHRE SO

FErd; Place & Route, AT HIIRIEE 5.

® Run: A Place & Route ik Jy | 5t @@ wf, merizi
Tfi4xiz4T Place & Route;

® Rerun: it Place & Route &l FIRAS, EPEZED, FHHrislr
Place & Route;

® Clean: &F&iz4T Place & Route =4 3cF3% (pnr) FIIFTA X
A Jo SCAH 5

® Configuration: A%} Place & Route ST & .

5.4.5 Program Device

SUG100-1.6

DIRAMAEAT AT LB AT T G, SAEREERRR S (s 30fP), &8
S-Sk FPGA gufe sy, A nlig tuRrmt e F B F, S P TR
I TRE o
VE
Program Device ##§i T- Synthesize % Place & Route ¥, HATIZA TN, w0 H AR5

(Synthesize /% Place & Route) K47, 2xifthE SR, Wk 5-40 & 5-41 k.

5-40 B 7)) Program Device E&H127R

rw Warning l&w

Bitstream file does not exists.

Wit “Program Device” SR7EZIAEHS “Run” &I, I mmF
Sk FPGA 9mfeds, WK 5-41 fis.
E!
Linux 222540 Fp (1 4 F2 2838 F T Linux iR A Red Hat 5.10, 17 Red Hat 6/7 A [ 40 72 2%,
HEIE M L NERZEE, BB Gowin 2 I HT 225 6 ) SR

“Programmer”

l.\'
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[ 5-41 Programmer & H

N
¥ Programmer 2 =[5 |-

File Edit About

= =

Enable Family Device Operation File Checksum User Code
1 GWIN GWI1N-4 SRAM Program Difgowin_project/1.9.0/fpga_project_1/impl... 0112 00000112

| +
Output 8 x
Ready

HRE =518 FPGA HmiE2s AN 771k, 5% _(Gowin
Programmer #7557 )-

5.5 IR h B

i PL R UB H IDE:
1. i “File > Exit” &,
2. AR HA AR m”,
!
o I RMAFIISCHE, WIS Fe iR & X SR AT R A7
o IDE #HtH{R1FE (Save). RfEFTH (Save Al) fiA{7 A (SaveAs...) Thfg R
BT X6 SUAS G 48 Bh VB IR AR AT
e IDE X T AL E (Configuration) {5 2 I1E L El %t THE SO B3G5 E AN 2
RUEH R A7 B TRERCE S, 78 IDE X HFIRS H 3 RA7
o R e T, kdEd iRt IDE.
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6%}%7&1#%5&21&

6.1 Synplify Pro

Synplify Pro /2 Synopsys 2 i Jaifi 2 Sk % T 15 BRI £ 4 A
SRR PSR LS, S0F VHDL. Verilog 5421 .

%F Synplify Pro [V E401E 5 M E1E 15 5% Synplify Pro 44 5“Help
[T HI N T RS

6.2 FloorPlanner

Gowin FloorPlanner & 5z - SR 7 T 3 5 £ & A6 /i S E 20
St T H, SZRES /0. Primitive (JRiE). block (f7-fif#HE. DSP). Group
SR M AL BAR B R S ThRE, R R AR B FH P RO IC B AR GET AR
RS2, et e T V0 et E R, EE. BRI B S B
Gowin FloorPlanner $2fit T & KA R 5 A R miEThRE, W fimo
SRR &K FPGA 85 7% o

J& 7)) FloorPlanner P #7520
1. KRB FGPA LFERT, A EHIZEHASERAN “Tools” Fhidk dik#

“FloorPlanner” , i, FEilid File>new HNEL M 2 F L) ok S0 f T

RIE R
2. 57 FPGA LfEH), HZEAMFEEFHX NS “FloorPlanner” , i,

FloorPlanner £ B N#k TR SO H 2 7R 7E FloorPlanner S

FloorPlanner 43> Chip Array 11 Package View PN 1, 40

6-1 f1 & 6-2 o, % LEMIVEAE R %15 % (Gowin #7724
F1ERE ). Bt 4 FloorPlanner iAo LLiEAT IS FEARAL
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[& 6-1 Chip Array @O

7 FloorPlanner

File Tools View Help

# Inte LEAULLE § Parzing netlizt file

* 0 fUsersfliyangdl/Docoment s/ fpga_project_1/inpl/synthesize/rev_1/ fpga_project L wn’ conpletsd

> Infe  (PADODB) © Processing metlist conpleted

> Infe  (MEOODS) © resding eomstraint "C:fUsers/liyangdl/Decunents/fpga_project_1fsre/fpga project_L, ost”
> Info  (CTOODZ) © Physical Constraint parsed completed

e [ T/0 C | Primitive G

DEAE@ <
Lizt 8 X || Chip drray [ ‘ Package View
4 0 counter
> L Ports (10)
> | Primitives (16)
[ Nets (28)
> I Module
» | Timing Paths
Mezzage g X

Group O | Resowrce R+ | Clock = | Guadrant C | Helk G | Vref C-

Ready

6-2 Package View B[

i FloorPlanner

Ele Tools View Help
DEHE®@ @
List & X | Chip Array Package View [ |
Project | Netlist
a [ counter _ ’ - i
[ Ports (10) 200000000000 EC
[ Primitives (16) - o 200000 o
[ Nets (28) — -
| Module 2 Q9 @ =
[ Timing Paths 9 QG .
® D ¢ SEIG
B € 90 e
1 £ D 2 &5
POOGG I
POGEG SEIE E
200 0e6 POOD O B
2ee 200008 B
B O C BOOOOC 3
Xt N &
R D 3 200006 B - @ -
PO 0C
8 0 6
Meszagze g x
7 Intao LFALIOOE T Farzing netli=t fa1le P
0 Alsers/iyangll focunent s/ fpga_project_1finpl/synthesizefrev |/ fpga project_1 wn’ conpleted
> Info  (FADODB) © Frocessing netlist completed.
> Info  MEOODS) @ reading constraint "CifVsers/livane0l/Docunents/fpea project Lfsroffpga project 1 cat”
> Info  (CTOD0Z) © Fhysical Comstraint parsed complatzd. i
Merr | T/0 = | Erimitive = | Growp O | Resowee =+ | Clock= | Guadrant = | Helk O | vref o
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6.3 RF )R 4w3Ee% (Timing Constraints Editor)

EaNFL R AR (Timing Constraints Editor) J2& &z 2 SR 5] 1
W ERER I P R g TR, SO 2RI P 20 A & 1, ELFE I b
ZI0 N AR RS LR AN Bl S 2R R4 . Timing Constraints
Editor 2t | fal S IRIE RN P 2R A DI RE, 7 SCHF A o R % FPGA
O i

J2 5 Timing Constraints Editor )75 2\ W i :

1. WARE FGPA TE, fEHf=r, 1k4% “Tools>Timing Constraints
Editor” , i, FEIE File>new n#k /%

2. s FPGA TR, fEid B HX, Xt “Timing Constraints Editor” ,
I Timing Constraints Editor <= H 4 in#k T34 SR 7E Timing
Constraints Editor 51fi, #411&l 6-3 Fizx.

A R P A R g A VR T U7 %, 1§25 _(Gowin 27/ 29 K757 )
6-3 RIS R E

A Gowin Timing Constraints Editor - C/Usersfroot/Documents/fpga_project_12/srcffpga_project_12.sdc = |5

Fle Constraints Reports View Help
=

Fetlist Tree & X |Timing Constraints Clock Name Type Period Frequency Rise Fall Divide by
i “ Clocks clicL B 10 100MHz 0 5
- Clock Latency
4 Y test Clock Uncertainty
Ports (6) Clock Group
Nets (14) 1/O Delay

Primitives (11) 4 Path

False Path
Max/Min Delay
Multicycle Path
4 Report

Report Timing
Report High Fanout Nets
Report Route Congestion
Report Min Pulse Width
Report Max Frequency
Report Exception

Set Operating Conditions

Conzole J x

create_clock —name clkl -period 10 -waveform {0 5} [get_ports {dini[1]}]

6.4 IP Core P24 8& (IP Core Generator)

IP Core Generator T.H FZH T/ A LML I & = A UL S =
RATHP, I8 THEP Ak Mt 2 J5, B P Al i A sl AL s s o
Wi T ERITRE . B RT IP Core Generator 4135 R iE A% Module 54> F1%:
HYFAISE 1P Core B KULRESSY, W 6-4 i,

B B S s T Tools R4t “IP Core Generator” 23] IP
Core Generator T. ., #1417 IP L.

FAREES 1P I 7532, 16225 SCM (Gowin 1P 2 1A/ 7 151 ).
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6.5 o (LR IB 43 HT (Gowin Analyzer Oscilloscope)

SUG100-1.6

& 6-4 IP Core Generator FH

Target Dewice: |  GHIN-LVAPGISECE/IS | E]

Mame

4 Hard Module
Block Memaory
CLOCK
DSP
4 [3C
[3C SDR
4 SPMI
SPMI
4 User Flash
= User Flash
4 Soft IP Core
CAN
DDRx
FIFO
[3C
MIPI
Math
Microprocessor System
PSRAM

SDRAM Controller

RAM Based Shift Register

Triple Speed Ethernet MAC

!

B K1) Hard Module 5% Soft IP Core ik #% 247 device IS ¥.
6.5 B LELIZE ST (Gowin Analyzer Oscilloscope)

BB IERIZH N (GAO) mm Y3 H BRI — 3K B F 555
PrCHE, BAER B P SN it S 5 2 mEN PR R, Pkt
1T R G HrAns e Ar, S it .

GAO ti14% Gowin GAO i & 1 Gowin Analyzer Oscilloscope 4™ T H .
Gowin GAO Mt & F Z A T M5 S A E B Wit , X s 8RBt
TRFER B, il B Ffil k#1550 Gowin Analyzer Oscilloscope @it
JTAG #2 LR A H FRAEE, % Gowin Core Inserter % & R FE(S S

Aoy EDUL Al R R s H K

JA 5 GAO 2 /i, mfE LAEEMHXHE GAO it E X (.gao), FTHAL

B, W 6-5 Fs.

53(73)




6 =IRBIER TR 6.6GPA I3t/ #1 T. B (Gowin Power Analyzer)

& 6-5 GAO it ERE

Optiuns | Capture Optiens

..........

nnnnnnnn

\\\\\ - Dusign Sumary W pgayreject i gu [+]

BLE XML G, fEsgst=dr, &4 “Tools > Gowin Analyzer
Oscilloscope, FTH E= - FMIELZHE NI T H, WK 6-6 Fix.
& 6-6 GAO R

Gowin Analyzer Oscillescope

Cable: |Farallel Fort (LET) ~ Y,

= [ [ |

Capture

Sterage Size: 1024 Window Nunber Capture dmount: (1084 v]  Trigger Positiom: 0

Trigger Expressions

expl: MO
Match Unit
Match Unit ~ Trigger Port  Match Type Function Counter Value
MO Trigger 0 Basic == Disabled 0

FELZ AR AT A B BE B AV I T VETE 275 _(GOWIN A=26:2°48 77 Br (KM
Wik /-1l

6.6 GPA ISR (Gowin Power Analyzer)

R T TR (GPA) N PRI AT REMERA I DI FE i, 1R 0 T
FEE T BRI, P RIARYE LR s AT AT IO B, i B it
HISERRENL, &z DFEZ A TSR 0 D6 73 B 45 S .

HAT, GPA THRMEZNE LN ERE X/ (gpa) Jylkit, ZERAN

THR:
1. ERGTAEEHEX (Design), #ii “File>New...” , I “New” X
THAE;
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2. %P “GPAConfig File” , fE#HIIE OHIHE “Name”;

3. Hdi “OK” , EIA7E “Design” & & F# ) GPA Config File;

4. N4, TEHESCIFmEIX EoR “GPA Config View” BIFTECE, a1l
6-7 Fiass

6-7 GPA BLEA |

General Setting | Rate Setting I Clock Setting

Device

Device: GH1H-1-QFF45-6

Operating Condition: COMMERCIAL - Process: TYFICAL -

Enviromment
Ambient Temperature: 25 000°C 2| (-40°C-100°C)

[7] custom Theta Jh: |25 00074
Heat Sink

@ Home () Low Profile () Medium Profile () High Profile () Custom

Custom Theta SA: |25 000°C/% |

EBoard Thermal Model

@ Home Custom Typical
Board Temperature: |25. 0007 S| -40C-100C)

Custom Theta JE: |25.000°C/H 5

Voltage
VOO 1140V 5 (1. 14¥-1.28¥)

VOCX: 2,500V 5| (2.5¥-3.3¥)

| ; Start Page | W GPA Confiz View B |

AR F IR TRECEME M 5%, 1§23 % _(Gowin #8757 #r 1 AN
S 15D

6.7 SRt B HNsR 1L 3 1 SndE =g

SUG100-1.6

P 230U A SO R — N ASCH S0, Hy 4 h.mi; H P iR dE B
BT ER, AR RO RS AT AR SR, DAFE e A7 s TR AR e TR
WIGHE -

PAFAE eI aa A SO B SR 4 9* mi(file_name.mi), U&7 E
—/NEAE T, AT BRI N R T N , ARR G i bE R S Address
Depth; FIEAREKENFAERIOHE 2/ 0400, RIWAERI SR %6 % Data Width.
Huhk A BB ARG, SEATEE SRR, (RTESG .

[P e e AL/ U A o - S W = 1] N o 1| IR 4 94 s AN =4 111 -
X, mi AR B R
—i##)#&5 (Bin File)

Bin SCAH A&t R O A 1 AL SCA SO, AT BURERAT i A 1 ki
R, FIBURERAF s 8 s 58 5

#File_format=Bin

55(73)




6 mIRHAF AR TR

6.7 PAF AU S F 9 45
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#Address_depth=16

#Data_width=32
00001100000100000000100100010000
10000000010010000100000001000000
01000000100000001000000010000000
00100000100001001100000011000000
00000100000001000000010000000100
01000010001010100000101000001010
00100010010001000000010001000110
01000101000001110000010101000001
01100100001001001000010000100100
01001001010010010010100101001001
01100101001001010000010100100101
11000001101001010000010110100101
01001000100010000010110000001100
10000101001011010100110100101101
01101100001100110000011100011001
00001001001010010100000110010000

7NiEtEHIE (Hex File)

Hex (145 Bin SCPFRS AL, o8kl 8 O~F 4k, 1T HURAA#

#File_format=Hex
#Address_depth=8
#Data_width=16
3A40

A28E

0B52

1C49

D602

0801

03E6

4C18

1. rHhE oS EEH R 20 (Address-Hex File)

AR HHBIEIRE, AT HR A R AR, ACERA S BB 9

Address-Hex SCF & 15 SO A 5 A Fedi i 5% i sk Fn B AR 31710 3%,

M BEANHARE S Nt O~F Ak, AT E ST tit, B9 )51
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REHE, SR R B N EdE F A B AT IE %, R e S EEER A
BN 0.

#File_format=AddrHex
#Address_depth=256
#Data_width=16
9:FFFF

23:00E0

2a:001F

30:1E00

1oz B A SRR A SO R G 42 AT BC B SCPF Cmid DA, 9146

WA g i BAR D SR h -

1.

2.

3.

2.

3.

SUG100-1.6

FERAE TR FIX (Design), #id “File> New...” , #17F “New” &
BE
#FE “Memory Initiazation File”, 118 6-8 fs i “OK”, FEFH 1

New File $&/~HE S WG AT 47 )5 i “OK”, Wil 6-9 Fk:
Ja sl 6-10 B BTG AL SO EC B FETm . T 1 22 R 4 R A 3B S Y146
fEL, A0S 23 Fic BT 46 A SCA R /N R LA =X

E TG B S A TC B 146 A0 S 14 1 Depth AT Width,  BLR 72 | 4% H

Hy b FIRT AR I BUE o ig 2.

e Depth Fl Width % 5 H F' 7t IP Core Generator 5[] - frig#
BSRAM [¥] Address Depth }%¢ Data Width —%{, ¥ #1440
Address Depth B\ Data Width KT 541f b i #){E, IP Core
Generator B2 (E H ;. #F Address Depth 5 Data Width /s
T& B ERTIR e, R E Kk T fEER ARG 0,
WHESE LT “Update”;

® AN b RN ERAE Y Ak AT DA ke, oSk, i
2[5 VAN i I e

TE 0 B S TH 6 20 A A AT WG AE S N BEAME ZE A% A ] DX 3R

& IR A AT I E

o EHIFLAEI LA ESNBME R, B 1. 8. 16 =Fhik#F, K 6-11
Ffrm s

o RAIEHAILAERE T Ll i X f5 F3h 5 N, tnT DU A Bl AT %
B, EEEmABELA AR, %5 “Fillwith0” ZFR¥IEAE N 0, “Fill
with 17 ZFE ¥R EEALER N 1, “Custom Fill” {# F F AT DURE 75 2
BHATEE S N, FFEETHCE R BV E K 6-12 Fix.

TRAT LA
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B 6-8 MIAHSTHHTE New f27R4HE

-
ﬂ:«- Mew

=)

& VHDL File

EE; Physical Constraints File
EE; Timing Constraints File
| 5, GAO Config File

| -, GPA Config File

] Memory Initialization File

m

1

Create

memory initialization file

0K

|| Ccancel

& 6-9 #MiESCEFTIE New File 127R4E

-
3& New File

Hame:

Create in:

test

C:WUsershroothDesktop'l. BIDE test izre

.mi b

Browsa. .

| (ot )
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& 6-10 #iBSCHELE R

| DA\gowinTaskitestiDE\gpri\fpge_project_4\src\testt.mi
+0 +1 <2 <3 4 +5 0 A e

00000000 00 00 00 00 00 00 FoE—

00001000 00 00 00 00 00 00 Depth:  [256 5

00010000 00 il il 00 00 il i

00011000 00 00 00 00 00 il

00100000 00 00 00 00 00 00 View

00101000 00 00 00 o0 o0 00 Address Base:

00110000 00 00 00 00 00 00 Veue Base:  [Hex -

00111000 00 00 00 00 00 00

01000000 00 0 0 0 0 0

01001000 00 0 0 0 0 0

01010000 00 0 0 0 0 0

01011000 00 0 0 0 0 0

01100000 00 0 0 0 0 0

01101000 00 0 0 0 0 0

01110000 00 0 0 0 0 0

01111000 00 0 0 0 0 0

10000000 00 00 00 00 00 00

10001000 00 00 00 00 00 00

10010000 00 00 00 00 00 00

10011000 00 00 00 00 00 00 .

< >
[ 6-11 FIKECE

0 +1 <2 +3 +4 5 +6 + 1 Column

00000000 00 00 00 00 00 00 00 _. 3 Column
00001000 00 00 00 00 00 00 00 16 Column

E 6-12 HBIGE

+0 +1 +2 +3 +4 +5 +6 +T
ononcooo N O I NN N S R R
onorvoo0 N O R RN N S R R
ooerocoo N O R S S - C R R
oovcooco K N S O - N G
oovorooo S N S O S O I
[uli}

Fill with 1

01001000 00 a0 a0 o0 o0 00 00
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7 IR S 7.1 A A Eedh it

Py NG T B

iz s IRBATE FPGA Bt fed, BrA S EURFRL SCAR BLAR, R mlaE
ARSI S, FTAHEREZA Gowin ZIRRAHRE I 2%, BRilE
JRA R T B AT R AT LA i BRSO I P A DA A 5 55
tbah, F P RE A B Place & Route, 18 2URL B R VA= i IR 2 ST
s PR SO

7.1 HRHERRE

Z‘ﬁﬁﬁ‘ﬁ@%ﬁ » FIH TR P& S R TG R NAAHEFEE R
IRNEIMEP =P, ﬁ@fﬁ):‘ TR R 5 H bRt v & S ILE S N 25 .
AR A A rpthtml,  BARME BT & E* rpt.html 301

FH P Al R P4 FEIX [ Place & Route [X, XUii “Place & Route

Report” , #1HF FPGA LTFEXI N FAm A e die &, @l 7-1 Froso
[# 7-1 Place&Route Report

PnR Messages

PnR Details

7.2 i RIER S

it 1 JE PR 70 A ) 2 J5 i s P 11 Ja8 e () ST A, G oy AR 88
JE 1 R AL BAS A, AR S E &4 8. pinhtml, BAR(E BT EEH
* pin.html 3245

Fi P AT eI R FE X 1 Place & Route [X, i “Ports & Pins Report” ,
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7 RS S A4 7.3 I PR

77T FPGA AR B 3 1 s PE A i, W& 7-2 Foss
[ 7-2 Ports & Pins Report

‘GOWIN FPGA Desi Dgo
 Fle Edit Jools Window Help

5 x
+ PinMessages Pin Messages
- Pin Details
o Pinout by Port Name Report Title
< All Package Pins Design File
Physical Constraints File
Timing Constraints File D:\gowin_project\1.9.0\fpga_project_1\src\fpga_project_1.sdc
Place & Route Report GOWIN Version v1.9.0Beta
Timing Analysis Report Part Number GW IN-LV4PG256C6/15

Created Time Tue Feb 26 18:03:42 2019

Legal Announcement Copyright (C)2014-2019 Gowin Semiconductor Corporation. Al rights reserved.

Pin Details
Pinout by Port Name:

Port Name Loc./Bank | Dir. | Site 1/0 Type prive |PullMode | sk

7.3 Bk

IS P i 2 i LR S B P R SR B I P i I DR A SCAR S L, BRIA N
WA A 2

H A=A B AR 1S LG E L (R R B OREFI (Al 2, ik S I [l 7
FEBRI AR 7 o S /NI Dk bR 28 L e R Bt HH B AR AT R AP 28 R o 55304
BOAEOL I FIRFr AR EFATIR Y, FRR AR AR R

F P aTE S AL X 1 Place & Route X, Wi “Timing Analysis
Report” , fTJF FPGA TR NI Fpdi i, @il 7-3 Frox.
7-3 MIFR&ERNE

[ GOWIN FPGA Desi Big

7 fle Edit ools Window Help

Timing Messages
» Timing Summaries

Timing Messages

STA Tool Run Summary
Clock Summary Report Title Gowin Timing Analysis Report

Max Frequency Summary Design File D:/gowin_project/1.9.0/fpga_project_1/impl/synplify/rev_1/fpga_project_1.vm

Total Negative Slack Summary Physical Constraints File Di\gowin_project\1.9.0\fpga_project_1\src\ipga_project_1.cst
4 © Place & Route \ Timing Details Timing Constraints File Di\gowin_project\1.9.0\fpga_project_1\src\fpga_project_t.sdc
Place & Route Report GOWIN version v1.9.08eta
Timing Analysis Report » Path Slacks Table Part Number GW1IN-LVAPG256CE/15
Ports & Pins Report Setup Paths Table Created Time Tue Feb 26 18:03:42 2019
Pawer Analysis Repart Hold Paths Table Legal Announcement Copyright (C)2014-2019 Gowin Semiconductor Corporation. All rights reserved.

i Program Device Recovery Paths Table

Removal Paths Table L
Minimum Pulse Width Table Timing Summaries

» Timing Report By Analysis Typ
STA Tool Run Summary:

Setup Analysis Report

74 DM E

ATty BB B, ARYE A RO PEf—A TAG R Zh AR
TR, B P VRS B AR D REE

F P el fERE FE A HEIX ) Place & Route [X, XUili “Power Analysis
Report” , AJ$]J FPGA TFEX M. I DhFe ik, Wil 7-4 Fos.

AARIFED MR R, 1625 _(Gowin LJ#E 7pr LA 157 )
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E 7-4 hESHRE

 Hle Edit Tools Window Help

FECLL

Process

I Design Summary
4 [77 User Constraints
7| FloorPlanner
| Timing Constraints Editor
4 (O synthesize
Synthesis Report
Netlist File
© Place & Route
Place & Route Report
Timing Analysis Report
Ports & Pins Report
~ Power Analysis Report

BB Program Device

Power Messages
Power Summary

Power Information

Thermal Information

Configure Information

Supply Information

Power Details

= Power By Block Type
= Power By Hierarchy

o« Power By Clock Domain

Power Messages

Report Title Gowin Power Analysis Report

Design File D:/gowin_project/1.9.0/fpga_project_1/impl/synplify/rev_1/fpga_project_1.vm
Physical Constraints File D:\gowin_project\1.9.0\fpga_project_1\src\fpga_project_1.cst
Timing Constraints File D:\gowin_project\1.9.0\fpga_project_1\src\fpga_project_1.sdc
GOWIN Version

Part Number

v1.9.0Beta
GWIN-LV4PG256C6/15

Created Time Tue Feb 26 18:03:42 2018

Legal Announcement Copyright (£)2014-2019 Gowin Semiconducter Corporation. All rights reserved.

Power Summary
Power Information:

Total Pawer (mw) 4.563

62(73)




3% A SynplifyPro J& 1 K 387w

B 5% A SynplifyPro B X f87R~

Al wERM IR

full _case

T Verilog 1) case 5], RUIFTA T REAIPRE O, A LA
AR RS 5 0H .

BE

object /* synthesis full_case */ ;

Pi B3

object 7]y case. casex. casez.
parallel_case

U T Verilog ' case 157], RMIAM —NIATIZ BIEFEEEH, ML
VR BT A

A

object /* synthesis parallel_case */ ;

LB

Object 7] 4 case. casex. casez.
translate_on/translate off

MTAREHAZRE AT, WEEHEEE . fELRa, ERAN R T E
A RN, JRa] T AERACRS Fh i — By H A .

%

[* synthesis translate_off */
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code
/* synthesis translate_on */
syn_encoding
5 Il PRI A B S B 77 2
B
object /* synthesis syn_encoding = "value" */ ;
i B3
e object RIRETFAEAE s
e value FJfHELFE:
- default: Z#& THES HARFEmID )T SOk B i PERe 45 2R
- onehot: KHIMEAL GG TT
- gray: KA E MR TT
- sequential: ¥H H A 405 77 2
- safe: WIARERIAAE AR LEH BRI F A
- original: & E4mt5 77, (2P HIRSHATIRESHUF AT AT P43
1:)’:[‘0
syn_keep
TRUEZ TR E 1 wire TEZRE AL TR OREEAS, Ao,
B
object /* synthesis syn_keep = 0|1 */ ;
i B3
object /& wire 5% reg /X 4.
syn_hier

FEHITEAALES X —~ Moudle B Component S5 (1732 5 ¥ 2 AL AL B, 1% ) 14
AT B 2 AR

BE

fE FDC At

define_attribute {object } syn_hier { value }
define_global_attribute syn_hier {flatten}

7t Verilog S EH

object /* synthesis syn_hier = " value " */ ;

E VHDL S

attribute syn_hier of object : architecture is " value " ;

BB

syn_hier F{E fL4E:

e soft (GREME): Synplify Y RILHIILS, REEmTEE 1t
o firm: CREFUCIHHITHI I SRVF cell PEIA T, R EMTEE BT,
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e hard: EREORBE BTG A S R R0 R R T

o fixed: fRAFEIFHICHIEN, [EER (kAT B L APAT 198 2 Uk S AR B v
FHEsAmP

o remove: ERRFAINZEMEMZIR, (HAR W HEARE R P IT;

e macro: JEREOR B BT S I AT A

o flatten: ERITA KT ZEMENEZIRNZIRAZ, APk flatten F1H A 4H &
F . tn flatten,soft 25T flatten; flatten,firm ALK T & M FT e E IR T 21k,
5B T BT 1K) LTI BE O 5 R L cell IARAL; flatten,remove “FTHI 1L AL 45 &
PERTTE 2 MK T Z IR TR 2R, TEARJE 75 B 128 1 B AE 12 75 B )X

— R 1.
loop_limit
fE verilog SCAFH, HEMARE R AR, WA —EHS, f5EMAEAIE
BT BR 1 o

BE

beginning_of loop_statement /* synthesis loop_limit integer */;
syn_looplimit

FE vhdl ST, B R — AN, AR — RN, 8 EMmA AT

MHIBCTH PR A

BE

attribute syn_looplimit : integer;

attribute syn_looplimit of labelName : label is value;
syn_noprune

PR ALRFF— A B Z > component [RISEA, 1 AN oy HY BE 15 58 BRI o — LA
B AR IIE LT AR Ay o 11 ) S5 22 AR RS IS o

A

£ FDC (e

define_attribute {modulejinstance} syn_noprune {0|1}

7t Verilog 3 EH

object /* synthesis syn_noprune = 1 */;

E VHDL (A

attribute syn_noprune : boolean

i

Object 7]y module. declaration, =%# Al A5,
syn_preserve

FHAERC B AT () 55 A7 e Bk b, AEREER iR ) P 25 A7 asfE AR AL DR A2l
WA RS € RS LR DAL NSl

Bk
7t Verilog 3 HEH
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object /* synthesis syn_preserve =0 |1 */

E VHDL SCfFH:

attribute syn_preserve of object : objectType is true | false;
B

object n] N A7 E S 5 B & Module 4.

A2 SR M R FE R

syn_allow_retiming
T ZF A a2 5 ) I A & 8 4R DL S 1 R
Bk
£ FDC (e
define_attribute {register} syn_allow_retiming {1|0}
define_global_attribute syn_allow_retiming {1|0}
£ Verilog 3 PEH
object /* synthesis syn_allow_retiming =0 | 1 */;
E VHDL S+
attribute syn_allow_retiming of object : objectType is true | false;
syn_ramstyle

i et RAMS FSZEL J512%, WNas A7 2S BN A7 ER &S . nPE i @ i in T RAM
IR B A 215 5 B RAM S 4 .

BE

E FDC (A,

define_attribute { signalname [ bitRange ]} -syn_ramstyle value

define_global_attribute syn_ramstyle value

1E Verilog X4+ -

object /* synthesis syn_ramstyle =value */

E VHDL S

attribute syn_ramstyle of object : objectType is value;
syn_romstyle

i€ ROM [{seiZety, 78 Synplify Pro 1] case iE4)4: ik ROMs £ /b4
— R HIERR T RUE, AR AE BT ROM SE3L ROM.

ENS
7E£ FDC 4.

define_attribute { romPrimitive } syn_romstyle {logic | block_ram | I[pm_rom |
MLAB | distributed | select_rom }
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7t Verilog SCHEH

object /* synthesis syn_romstyle = "logic | block_ram | [pm_rom | MLAB |
distributed | select_rom" */;

7E VHDL 344

attribute syn_romstyle of object : objectType is "logic | block_ram | I[pm_rom |
MLAB | distributed | select_rom";

syn_replicate

FEDC A ST 125 1) 25 A7 1 21 o

B

£ FDC X+

define_global_attribute syn_replicate {0 | 1};

£ Verilog 3 2EH

object /* synthesis syn_replicate =1 | 0 */;

fE VHDL S+

attribute syn_replicate : boolean;

attribute syn_replicate of object : signal is true|false;
syn_direct_enable

FHIBE R SR E — 2k B BE net Zr L4 4R € A R T I RE i, SR

LN A A AL

BE

fE FDC (A

efine_attribute {object} syn_direct_enable {1};

1E Verilog X4+

object /* synthesis syn_direct_enable = 1 */,

E VHDL S

attribute syn_direct_enable of object : objectType is true;
syn_direct_reset

FEHIBTE R SR E — 2% net 73 lC4 48 7 1 [FB A7 B IT ) reset Ui

i

fE FDC ST

define_attribute syn_direct_reset {0|1};

7t Verilog SCPFH

object /* synthesis syn_direct_reset = 0|1*/;

E VHDL S

attribute syn_direct_reset : boolean;

attribute syn_direct_reset of Object : signal is truelfalse;
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syn_direct_set

FEHIR TR R E — 2% net ZpHic4s 48 € M RD A7 Ml BT Y set i
BE

£ FDC X+

define_attribute syn_direct_set {0|1};

1t Verilog X4+ :

object /* synthesis syn_direct_set = 0|1*/;

E VHDL S+

attribute syn_direct_set : boolean;

attribute syn_direct_set of Object : signal is true|false;

syn_black _box

H¥

Syn_black_box 154 H T # e iy il & 456, ARIZBERNEREA

BRI 1 Sl & Lo

BE

fE FDC (A4

define_attribute { object {syn_black_box}{1}
£ Verilog 3C#FH

object /* synthesis syn_black_box */;

E VHDL

attribute syn_black _box of object : objectType is true;

syn_maxfan

BB ARG net BUAT A S o 6 e tHAE .
A

£ FDC (A

define_attribute {object} syn_maxfan {integer}

£ Verilog 3 2EH

object /* synthesis syn_maxfan = "value" */;

fE VHDL

attribute syn_maxfan of object : objectType is "value";

syn_pipeline

FOVFARF BRAE I 45% J T 0 27 A7 2 18 N\ TRV o SE I LASR e D36
S

£ FDC A+

define_attribute { register } syn_pipeline {0|1}

7t Verilog SCHFH
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object /* synthesis syn_pipeline = {1|0} */ ;
£ VHDL 3Cff:

attribute syn_pipeline of object : objectType is {truelfalse};

syn_probe

IR 3 CABEIU AT 100 P 5845 5

Bk

£ FDC X+

define_attribute {n:netName} syn_probe{probePortname|1|0}
7 Verilog SCHFH

object /* synthesis syn_probe = "string" | 1| 0 */;

E VHDL S+

attribute syn_probe of object : signal is "string" | 1 | O;

syn_useenables

77 17 A I b A5 B S Y A7 4

BE

fE FDC (A

define attribute {register|signal} syn_useenables {0|1}

£ Verilog 3C#EH

object /* synthesis syn_useenables = "0|1" */,

E VHDL S

attribute syn_useenables of object : objectType is "true|false”;

syn_netlist_hierarchy

GUE B v PUERGE R AL RS T, T TR 4R e

B

E FDC (A

define_global_attribute syn_netlist_hierarchy {0 | 1}
1E Verilog X4+

object /* synthesis syn_netlist_hierarchy =0 | 1 */;
E VHDL S

attribute syn_netlist_hierarchy of object : objectType is true | false;

69(73)




F3% B it

BsR B pajwn:l

LALR it demo.v 9, iz el 456 Gowin =Y 4 A«
module demo (clk_50M,rst_n,led);

input clk_50M,;

input rst_n;

output[3:0] led;

reg[3:0] led,;

reg[24:0] cnt;

reg clk_led;

always@(posedge clk_50M or negedge rst_n) begin
if (Irst_n) begin

clk_led <=1'b0;
cnt <= 25'd0;
end
else begin

if (cnt == 25'd2499_9999) begin
clk_led<=~clk_led;
cnt<= 25'd0;

end

else begin
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cnt <=cnt + 25'd1,
end
end
end
always@ (posedge clk_led or negedge rst_n) begin
if('rst_n) begin

led <= 4'h1,;
end
else begin
led <= {led[2:0],led[3]};
end
end
endmodule
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Ffy 3¢ B Wit bl B.1 & 7 TF%E

B.1EMVTIE

17 Gowin ZIR#MF )5 25 5.1 frdt TR 6.2 T TR TREIF
i demo.v FITAE, BoEBIHEYE, WHE B-1 fis.

& B-1 Gowin =& IDE

{4 COWIN FPGA Designer - (Desgn Surmmany] T A © gy -
Eile Edit Jools Window Help

5 =l % Tl

BEHE j hio&
Design 8 %

GWIN-LVAPG256C6/15 Project File: D:\gowin_project\1.9.0\fpga_project_1\fpga_project_1.gpr]
HDL Files Synthesis Tool: SynplifyPro
src/demav

Target Device

Part Number: GW1N-LV4PG256C6/I5

Series: GWIN
Device: GWIN-4
Package: PBGA256
Speed Grade: Ce/I5
Core Voltage: Lv

,=—
B.2 BITI
AT TR =k
1. £ “Process” & 10, X “Synthesize” 8 #.i7 R AR A #EEFE “Run”,
AT P B SR A LA R
2. */—\%EEEE, X “Place & Route” o Fidy AR A BEERE “Run”, 3

TLEE TG MR A A 4k 7= 4 bitstream XX, & B-2 s
3] B-2 TIEARE

{4 GOWIN FPGA Designer - [Design Summary]

Ele Edit Tools Window Help

S

Project File: D:tgowin_project'1.9.0\foga_project_1\fpga_project_1.gprj
Synthesis Tool: SynplifyPro
Target Devic
Synthesis Report
o Part Number: GW IN-LV4PG256C6/15
Netlist File
4 @ Place & Route Series: Gwin
Place & Route Report DT GWIN-4
Timing Analysis Report Package: PBGA256
Ports & Pins Report Speed Grade: C6/15
Power Analysis Report Core Voltage: v
IHf program Device

B.3 T# LR
FLgER T 805 X R -
1. BiTRfiRAf%Z )G, £ “Process” &M, i “Program Device” &,

FABES “Run”, TIF F&#s A, WK B-3 fn, LHRSESIN
2 A [1 bitstream SO R #8E

2. i “ 0 7, HAT bitstream ST E
!

o  JRAi@EIt LR AT bitstream AT #:
o [FHIPIERE F5.
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# B-3 THis5AHE

r N
s Programmer 2 — — - = | =) ]
File Edit About
ms=s | | i
Enable Family Device Operation File Checksum  User Code
1 GWIN GWIN-4  SRAM Program CifUsers/root/Documents/fpga_project_12/... C5F6 0000C5F6
4 , 3
Dutput 8 x
Ready
L
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